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Введение 

 
Образовательные результаты, заявленные в ФГОС по ПМ.01 Проектирование цифровых 
устройств  
уметь: 

– выполнять анализ и синтез комбинационных схем; 
– проводить исследования работы цифровых устройств и проверку их на 

работоспособность; 
– разрабатывать схемы цифровых устройств на основе интегральных схем разной 

степени интеграции; 
– выполнять требования технического задания на проектирование цифровых устройств; 
– проектировать топологию печатных плат, конструктивно-технологические модули 

первого уровня с применением пакетов прикладных программ; 
– разрабатывать комплект конструкторской документации с использованием САПР; 
– определять показатели надежности и давать оценку качества СВТ; 
– выполнять требования нормативно-технической документации; 

знать: 
– арифметические и логические основы цифровой техники; 
– правила оформления схем цифровых устройств; 
– принципы построения цифровых устройств;  
– основы микропроцессорной техники; 
– основные задачи и этапы проектирования цифровых устройств; 
– конструкторскую документацию, используемую при проектировании; 
– условия эксплуатации цифровых устройств, обеспечение их помехоустойчивости и 

тепловых режимов, защиты от механических воздействий и агрессивной среды; 
– особенности применения систем автоматизированного проектирования, пакеты 

прикладных программ; 
– методы оценки качества и надежности цифровых устройств; 
– основы технологических процессов производства СВТ; 
– нормативно-техническую документацию: инструкции, регламенты, процедуры, 

технические условия и нормативы. 
 

 Окончательная оценка выставляется обучающемуся за предоставленный отчёт и 
устный опрос о проделанной работе: 

- оценка «5» - за полностью выполненную работу, оформленный отчёт и полные 
ответы на контрольные вопросы; 

- оценка «4» - за полностью правильно выполненную работу, оформленный отчёт, за 
неточные ответы на контрольные вопросы; 

- оценка «3» - за правильно оформленную работу, оформленный отчёт, за неточные 
ответы на контрольные и наводящие вопросы; 

- оценка «2» -  за не полностью выполненную работу, не оформленный отчет. 
 

 
 
 
 
 
 
 
 



 
 
 

Общие указания по составлению отчёта 
 

Практические работы являются одним из элементов учебной деятельности студента, 
выполнив которую, он должен составить отчёт.  

Правильно составить отчёт, значит показать: 
- степень усвоения знаний; 
- умение проявить самостоятельность, творческий подход к выполнению заданий; 
- знание нормативных документов, ГОСТов, ЕСКД; 
- оптимальную организацию своей работы, чтобы с наименьшими 
затратами времени и труда найти эффективное  техническое, математическое 
и другое решение; 
- умение пользоваться справочной, информационной, нормативной литературой, 
ресурсами Интернет. 

Отчёт выполняется рукописным способом на обеих сторонах листа формата А 4. 
Оформление отчёта выполняется в соответствии с методическими указаниями по 
применению стандартов при оформлении учебной документации, текст отчёта 
иллюстрируется при необходимости графическим материалом в виде рисунков, схем, 
таблиц. Текст отчёта пишется пастой синего цвета. Отчёт составляется в соответствии с 
методическими указаниями к работе на основе результатов выполненной работы. 

Проверяя отчёт, преподаватель отмечает: 
-правильность оформления отчёта, т.е. соблюдение требований ГОСТ, 

ЕСКД и других нормативных документов; 
-правильность выполнения задания; 
-достоверность полученных результатов; 
-ответы на контрольные вопросы и выводы по работе. 
Преподаватель отмечает ошибки и выставляет оценку. В случае не-

удовлетворительной оценки отчёт возвращается. Студент исправляет ошибки и вновь 
сдаёт отчёт для проверки. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 

Практическое занятие №1 
Тема: Инструктаж по технике безопасности. Ознакомительная лабораторная работа в 
среде gEDA 
Цель: 1)Сформировать практические навыки при изучении программного обеспечения 
gEDA 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР, компьютер, ПО gEDA 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

gEDA — набор программного обеспечения для проектирования электронных 
устройств (САПР). Включает в себя инструменты для редактирования электрических схем, 
симуляции цифровых и аналоговых схем, трассировки печатных плат и подготовки к 
производству. Название gEDA происходит от английской аббревиатуры EDA (Electronic 
Design Automation) и префикса «g», типичного для открытых проектов, распространяемых 
под лицензией GPL. Оригинальный проект gEDA/gaf, разрабатываемый и 
поддерживаемый создателями проекта: 

-gschem — редактор электрических схем 
-gnetlist — генератор списка цепей (netlist) 
-gsymcheck — утилита проверки синтаксиса библиотечных символов (компонентов) 
-gattrib — редактор атрибутов символов в схеме в виде таблицы 
-libgeda — библиотека, предоставляющая API для gEDA/gaf 
-gsch2pcb — утилита генерации нетлиста для топологического редактора PCB 
-Наборы вспомогательных утилит. 
 
Самостоятельные программы, которые были включены в состав проекта: 
-PCB — редактор топологии печатных плат. 
-Gerbv — утилита просмотра файлов Gerber (фотошаблонов) 
-ngspice — симулятор смешанных электрических цепей (порт Berkeley SPICE) 
-GnuCap — современный симулятор электрических цепей 
-gspiceui — графический интерфейс (GUI) для ngspice/GnuCap 
-gwave — просмотрщик формы сигналов 
-Icarus Verilog — компилятор и симулятор языка Verilog уровня RTL 
-GTKWave — просмотрщик временных диаграмм цифровых сигналов 
-wcalc — средство расчета линий передачи. 

Запуск редактора схем 
 
Задание 1. Ответьте на вопросы, согласно заданию 
 
N 
вар 

1 вариант 2 вариант 3 вариант 4 вариант 

 Для чего 
предназначен 
редактор gEDA? 

Какие редакторы 
используются для 
редактирования 

В чем отличие 
gEDA от других 
редакторов? 

Какие модули 
входят в состав 
gEDA? 



схем? 
 
Задание 2. Опишите назначение следующих модулей программы 
 
N 
вар 

1 вариант 2 вариант 3 вариант 4 вариант 

 gschem 
gnetlist 
gsch2pcb 
 

GnuCap 
PCB 
GTKWav 
 

wcalc 
ngspice 
Icarus Verilog  
 

gnetlist  
libgeda 
Gerbv 
 

 
 
Контрольные вопросы: 
 
1. Для чего предназначен редактор gEDA? 
2. Какие редакторы используются для редактирования схем? 
3. В чем отличие gEDA от других редакторов? 
4. Какие модули входят в состав gEDA? 
 
 

Основные источники : 
 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств: учебник 

для студентов учреждений среднего профессионального образования. Издательство: 
Академия, Год издания: 2016 

 
Составил преподаватель                                                Васянович Н.А 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 

Практическое занятие №2 
 

Тема: Интерфейс пользователя в системе gEDA  
Цель: 1)Сформировать практические навыки при изучении программного обеспечения 
gEDA 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР, компьютер, ПО gEDA 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

На рисунке 1 представлено главное окно программы gschem. Программа имеет 
минималистский интерфейс, особенно в сравнении с коммерческими программами 
предназначенных для той же цели.  
 

 
 
Рисунок 1 – Окно программы 
 

Программа gschem, как было сказано, нужна для черчения принципиальной схемы 
нашего устройства. Она работает с файлами *.sch — собственно файл схемы и *.sym — 
файлы символов (представление конкретного компонента в принципиальной схеме). 

Лучше всего запускать gschem прямо из каталога, где находится файл со схемой 
(почему — объясню позднее) для этого можно настроить ваш менеджер файлов на запуск 
gschem при двойном клике на файлах *.sch. 

В gschem одновременно может быть открыто несколько страниц схем или символов. 
Каждой странице соответствует определённый файл на диске. Страницы схем сохраняются 
в файлах с расширением .sch, а страницы символов — с расширением .sym.  

Создание новых страниц и открытие старых 
 Если вы запустили gschem, не выбрав, какую схему или символ нужно открыть (см. 

Запуск gschem), gschem создаст и отобразит новую страницу схемы с рамкой основной 
надписи для формата “B”. Далее новые страницы можно создавать с помощью 
Файл→Новый [File→New] или Страница→Новая [Page→New].  

 Чтобы открыть страницу с диска, выберите Файл→Открыть… [File→Open…], в 
результате чего откроется окно выбора файла, где можно будет выбрать нужный файл. В 



меню, находящемся в нижней правой части этого окна, можно также выбрать, какие файлы 
должны быть показаны — схемы, символы, или и те, и другие.  

Навигация между страницами 
 Чтобы перейти на следующую открытую страницу, выберите Страница→Следующая 

[Page→Next] или нажмите <Page Down>. Чтобы перейти на предыдущую, выберите 
Страница→Предыдущая [Page→Previous] или нажмите <Page Up>.  

Сохранение страниц 
 Чтобы сохранить изменения в своей схеме или символе на диск, выберите 

Файл→Сохранить [File→Save]. Если вы работали с новой страницей и ещё не сохраняли 
её, gschem откроет окно выбора файла и предложит вам выбрать место сохранения.  

 Если вы работали над ранее сохранённой схемой, но хотели бы сохранить её в другой 
файл, выберите Файл→Сохранить как… [File→Save As…].  

Закрытие и возврат ранее сохранённых страниц 
 Чтобы закрыть текущую страницу, выберите Страница→Закрыть [Page→Close]. Если 

страница была изменена с момента последнего сохранения, gschem спросит вас, сохранить 
ли её перед закрытием. Если все открытые прежде схемы и символы закрыть, будет 
создана новая страница точно так же, как если бы вы выбрали Файл→Новый [File→New].  

 Если после изменения страницы вы решите вернуть старую, ранее сохранённую 
версию, выберите Файл→Возвратить [File→Revert] или Страница→Возвратить 
[Page→Revert]. gschem запросит у вас подтверждение того, что вы хотите отказаться от 
сделанных изменений.  

 Если нужно  выйти из gschem, в то время как несколько страниц ещё не сохранено, 
откроется окно с их списком, где можно будет выбрать, сохранять ли какие-нибудь 
страницы, и какие именно, или вернуться обратно к редактированию. 

Главные атрибуты: 
device — имя компонента в библиотеке; 
refdes — уникальное имя; 
footprint — тип корпуса и размеры; 
value — номинал элемента или его тип; 
netname — название соединения (видимое) используется для отображения названия 

соединения (например проводника) на схеме; 
net — техническое название соединения, используется при экспорте схемы в 

печатную плату и создания файла карты соединений; 
При выборе типа корпуса, если в используемом элементе этот тип не задан, 

необходимо: 
Запустить программу pcb; 
Вызвать обзор библиотеки; 
Подобрать требуемый компонент; 
Имя этого компонента используется как значение атрибута footprint 
Когда схема готова, возникает необходимость вывести её на печать или разместить 

изображение в Интернете. Программа имеет следующие возможности вывода: 
Печать схемы в файл формата PostScript или вывод на её на принтер с помощью 

задаваемой командной строки (Меню File->Print..., команда fp); 
Вывод изображения в графический файл (форматы png, jpg и другие) (Меню File-

>Write image..., команда fi); 
 



 
 
Рисунок 2 – Схема в программе gEDA 
 

Основные команды и их клавиатурные сокращения (если есть), которые потребуются 
при разработке практически любой схемы: 

-добавить компонент (кнопка на панели инструментов или через меню) – <i /> – 
открывает окно обзора библиотеки компонентов; 

-добавить проводник – <n /> – соединяем компоненты; 
-правка/удалить – <Delete /> – удаляет компонент; 
-правка/вращение – <e /><r /> (быстрое последовательное нажатие сначала на <e />, 

потом на <r />) – вращать компонент; 
-правка/зеркалирование – <e /><i /> – зеркалировать компонент; 
-атрибуты/автоматически нумеровать текст – <t /><u /> – задать автоматическую 

нумерацию компонентов. 
 
Задание 1. Опишите назначение следующих модулей программы 
 
N 
вар 

1 вариант 2 вариант 3 вариант 4 вариант 

 device 
value 
 

netname  
net 
 

footprint 
refdes 
 

value 
netname  
 

 
Задание 2. Опишите назначение следующих команд программы 
 
N 
вар 

1 вариант 2 вариант 3 вариант 4 вариант 

 <n />  
<Delete />  
 

<e /><r /> <t /><u /> <i /> –  
<r /> 
 

 
Задание 3. Создайте 3 страницы в программе, осуществите переход между ними. 
 



Контрольные вопросы: 
 
1. Для чего предназначен редактор gEDA? 
2. Какие редакторы используются для редактирования схем? 
3. В чем отличие gEDA от других редакторов? 
4. Какие модули входят в состав gEDA? 
 
 
Список используемой литературы 
 

 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                Васянович Н.А 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Практическое занятие№3 
Тема: Структура библиотек gEDA 
Цель: 1)Сформировать практические навыки при изучении программного обеспечения 
gEDA 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР, компьютер, ПО gEDA 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
 

Принципиальные схемы состоят из элементов (компонентов, символов) и связей 
(проводников, шин).  

В комплекте gEDA идет множество символов зарубежных компонентов, все они 
сгруппированы в библиотеки. 

Для вставки символа в схему нажмите 'i', появится окно библиотеки: 

 
 
Рисунок 1 – Библиотека gEDA 
 
Компоненты отсортированы по библиотекам, можно выбирать их оттуда или 

использовать фильтр. При выборе конкретного компонента в окне справа можно увидеть 
его изображение и атрибуты. Вставляется компонент на схему нажатием левой кнопки 
мыши, окно библиотеки закрывать не обязательно. При нажатии средней кнопки мыши 
компонент поворачивается на 90 градусов. (По умолчанию символы в файл со схемой 
вставляются как ссылки, то есть при изменении файла символа изменятся все символы на 
схеме. Можно внедрять символы в схему полностью или переключаться между этими 
двумя режимами для каждого символа отдельно уже после их вставки.) 

Можно вставлять на схему элементы. Для стандартных, вроде конденсаторов, 
резисторов, диодов есть их стандартные компоненты в нескольких вариантах, можно брать 
любой. Для микросхем нужно брать конкретный компонент (лучший вариант — 
использовать фильтр по названию). Обязательно нужно поместить «землю» (компонент 
gnd) и питание (vcc). Для перемычек используйте jumper, разъемов — connector (на схеме 
выводы идут в один ряд) или header (в два ряда). Стабилитроны — компонент zener. 

Бывают случаи, когда нужных элементов в базе нет. Тогда есть несколько вариантов. 
Во-первых, в базе http://www.gedasymbols.org/. Во-вторых, можно создать элемент самому. 

 



 
 

Задание 1. Запустите программу gEDA. Выберете компонент библиотеки. 
 
N 
вар 

1 вариант 2 вариант 3 вариант 4 вариант 

 микросхема 74595 
Power rails → vcc-
1.sym 

Basic devices → 
resistor-2.sym 
Power rails → gnd-
1.sym 

Diodes (generic) → 
led-2.sym 
Power rails → gnd-
1.sym 

Basic devices → 
capacitor-1.sym 
Power rails → 
gnd-1.sym 

 
Контрольные вопросы: 
 
1. Для чего предназначен редактор gEDA? 
2. Как открыть библиотеку программы? 
3. Как выбрать компонент библиотеки gEDA? 
4. Какие модули входят в состав gEDA? 
 
 
Список используемой литературы 
 

1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 
учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                Васянович Н.А 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Практическое занятие№4 
Тема: Выбор и редактирование объектов в gEDA 
Цель: 1)Сформировать практические навыки при изучении программного обеспечения 
gEDA 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР, компьютер, ПО gEDA 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Многие действия правки в gschem воздействуют на выделенные объекты. При 

отображении такие объекты подсвечиваются особым цветом.  
 В режиме “Выделение” [“Select Mode”] — режиме работы gschem, устанавливаемом 

по умолчанию, — для выделения объектов используется левая кнопка мыши. Если по 
какому-либо объекту щёлкнуть левой кнопкой, он будет выделен, а выделение со всего 
прочего снимется. Если щёлкнуть по фону рабочей области, выделение снимется со всех 
объектов. Если щёлкнуть и потащить мышь, удерживая левую кнопку нажатой, появится 
прямоугольная рамка, и когда кнопка будет отпущена, всё полностью находящееся внутри 
этой рамки будет выделено (это называется “выделением рамкой”). Это действие можно 
изменить, если удерживать нажатой клавишу <Shift>, — в этом случае объекты будут 
добавлены к текущему выделению, а не выделены вместо прежних.  

 Кроме того, можно удерживая <Ctrl> щёлкнуть по уже выделенному объекту — в 
этом случае выделение с него будет снято, в то время как прочие ранее выделенные 
объекты так и останутся выделенными.  

 Все объекты схемы или символа можно выделить с помощью Правка→Выделить всё 
[Edit→Select All], а полностью снять выделение со всех объектов — с помощью 
Правка→Снять выделение [Edit→Deselect].  

 В режим “Выделение” всегда можно вернуться из любого другого режима 
редактирования, нажав <S> или выбрав в меню Правка→Выделение [Edit→Select Mode]. 

Выделение соединений 
 Для выделения всего соединения целиком нужно сначала выделить один из его 

сегментов, щёлкнув по нему левой кнопкой мыши, а затем добавить к выделению все 
остальные соединённые с ним сегменты повторным щелчком по нему той же кнопкой.  

Выделение атрибутов компонентов 
 Если щёлкнуть левой кнопкой мыши по компоненту, он будет выделен вместе со 

всеми прикреплёнными к нему атрибутами.  
Заблокированные объекты 
 Некоторые объекты можно “заблокировать”. Заблокированные объекты 

отображаются менее ярким цветом и не могут быть выделены никак иначе, как только 
рамкой. Например, всегда блокируется добавляемая по умолчанию рамка основной 
надписи.  

 Чтобы заблокировать объект, выделите его и выберите Правка→Блокировка 
[Edit→Lock]. Чтобы разблокировать — выделите его рамкой (то есть, нажав и удерживая 
левую кнопку мыши, обведите объект рамкой) и выберите Правка→Разблокировка 
[Edit→Unlock]. 

Для изменения вида есть несколько средств:  
Панорамирование — нажмите среднюю кнопку мыши и, удерживая её, переместите 

курсор мыши в другое место или воспользуйтесь клавишами перемещения курсора 



(⇦⇧⇨⇩). Кроме того, вид можно отцентрировать по положению курсора мыши, нажав 
<X>. 

Увеличение масштаба — нажмите <Z> или прокрутите колёсико мыши вверх. 
Уменьшение масштаба — нажмите <Shift+Z> или прокрутите колёсико мыши вниз. 
 Чтобы сфокусироваться на конкретной части проекта, нажмите <W> и выделите 

рамкой интересующую вас область. Затем щёлкните левой кнопкой мыши, и эта часть 
будет расширена на всю видимую область окна. 

 Операции масштабирования всегда выполняются таким образом, что текущее 
положение курсора мыши становится центром области, получаемой в результате 
увеличения или уменьшения.  

 Можно также выбрать Вид→Уместить в окне [View→Zoom Extents], чтобы задать 
отображение всех находящихся на странице объектов, или Вид→Показать всё 
[View→Zoom Full], чтобы отображалось всё рабочее пространство целиком. 

Цветовые схемы 
 Для задания цветов объектов в схемах и символах используется ограниченная по 

размеру палитра, каждый цвет которой имеет особое значение. Например, соединения 
(имеющие схемотехническое назначение) вычерчиваются другим цветом, нежели линии 
(являющиеся простыми графическими примитивами). Для выбора цвета, которым должен 
отображаться каждый конкретный объект, используется цветовая схема.  

 Для gschem есть несколько цветовых схем, и между ними можно переключаться из 
меню Вид. Можно не только изменить используемую по умолчанию цветовую схему, но и 
создать свою собственную. 
 
Задание 1. Запустите программу gEDA. Выберете и вставьте следующие объекты. 
 
N 
вар 

1 вариант 2 вариант 3 вариант 4 вариант 

 Все имеющиеся 
коннекторы в 
библиотеке 

Микросхемы серии 
4000 

Микросхемы 
серии Xilinx 

Микросхемы 
памяти 

 
Задание 2.  
Постройте стабилизатор напряжения на микросхеме DA типа LM317. 
 

 
 
 
 



Контрольные вопросы: 
 
1. Для чего предназначен редактор gEDA? 
2. Как открыть библиотеку программы? 
3. Как выбрать компонент библиотеки gEDA? 
4. Какие модули входят в состав gEDA? 
 
 
Список используемой литературы 
 

1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 
учебник для студентов учреждений среднего профессионального образования. 
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Практическое занятие №5 
Тема: Перевод чисел в двоичную систему счисления 
Цель: 1)Сформировать практические навыки при переводе чисел из десятичной системы 
счисления в двоичную. 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

Двоичная система счисления используется для кодирования дискретного сигнала, 
потребителем которого является  вычислительная техника. Такое положение дел 
сложилось исторически, поскольку двоичный сигнал проще представлять на аппаратном 
уровне. В этой системе счисления для представления числа применяются два знака – 0 и 1. 

Для перевода чисел из одной системы счисления в другую существуют 
определенные правила. Они различаются в зависимости от формата числа – целое или 
правильная дробь. Для вещественных чисел используется комбинация правил перевода для 
целого числа и правильной дроби. 

Система счисления - это способ записи чисел с помощью заданного набора 
специальных знаков 

В этой системе всего две цифры - 0 и 1. Основание системы - число 2. Самая правая 
цифра числа показывает число единиц, следующая цифра - число двоек, следующая - 
число четверок и т.д. Двоичная система счисления позволяет закодировать любое 
натуральное число - представить его в виде последовательности нулей и единиц. 

Пример: 
10112 = 1*2^3 + 0*2*2+1*2^1+1*2^0 =1*8 + 1*2+1=1110 

 
Задание1: Перевести числа из десятичной системы счисления в двоичную 

N вар 1 вариант 2 вариант 3 вариант 
 55,171,118,200,155,167 

 
22,11,454,34,561,45 56,455,233,245,13,27 

 
Задание2: Перевести числа из двоичной системы счисления в двоичную 

N вар 1 вариант 2 вариант 3 вариант 
 10001,100000,1111 11111,10101,100011 11100,1000,101111 

 
Контрольные вопросы: 
1. Как осуществляется перевод чисел из десятичной системы в двоичную? 
2. Как осуществляется перевод чисел из двоичной системы в десятичную? 
Список литературы: 
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Практическое занятие №6 
Тема: Перевод чисел в восьмиричную  и шестнадцатиричную системы счисления 
Цель: 1)сформировать практические навыки при переводе чисел в восьмиричную 

систему счисления 
                     2) развивать интерес к изучаемой дисциплине 

Оснащение: МУ к ПР 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Существуют системы позиционные и непозиционные. 
В непозиционных системах счисления вес цифры не зависит от позиции, которую 

она занимает в числе. Так, например, в римской системе счисления в числе XXXII 
(тридцать два) вес цифры X в любой позиции равен просто десяти. 

Пример непозиционной системы счисления - римская. В качестве цифр в римской 
системе используются: I(1), V(5), X(10), L(50), C(100), D(500), M(1000). 

Величина числа в римской системе счисления определяется как сумма или разность 
цифр в числе. Если меньшая цифра стоит слева от большей, то она вычитается, если справа 
- прибавляется. 

Пример: CCXXXII=232; IX =9 
В позиционных системах счисления вес каждой цифры изменяется в зависимости от 

ее позиции в последовательности цифр, изображающих число.  
Любая позиционная система характеризуется своим основанием.  
Основание позиционной системы счисления - это количество различных знаков или 

символов, используемых для изображения цифр в данной системе.  
За основание можно принять любое натуральное число - два, три, четыре, 

шестнадцать и т.д. Следовательно, возможно бесконечное множество позиционных 
систем.  

Примеры позиционной системы счисления - двоичная, десятичная, восьмеричная, 
шестнадцатеричная системы счисления и т. д. 

Восьмеричная система счисления. В этой системе счисления 8 цифр: 0, 1, 2, 3, 4, 5, 6, 
7. Чтобы перевести в двоичную систему, например, число 611 (восьмеричное), надо 
заменить каждую цифру эквивалентной ей двоичной триадой (тройкой цифр). Легко 
догадаться, что для перевода многозначного двоичного числа в восьмиричную систему 
нужно разбить его на триады справа налево и заменить каждую триаду соответствующей 
восьмеричной цифрой.  

Шестнадцатеричная система счисления (шестнадцатеричные числа) — позиционная 
система счисления по целочисленному основанию 16. Обычно в качестве 
шестнадцатеричных цифр используются десятичные цифры от 0 до 9 и латинские буквы от 
A до F для обозначения цифр от 1010 до 1510, то есть (0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, 
E, F). 

Для перевода шестнадцатеричного числа в десятичное необходимо это число 
представить в виде суммы произведений степеней основания шестнадцатеричной системы 
счисления на соответствующие цифры в разрядах шестнадцатеричного числа. 

Например, требуется перевести шестнадцатеричное число 5A3 в десятичное. В этом 
числе 3 цифры. В соответствии с вышеуказанным правилом представим его в виде суммы 
степеней с основанием 16: 5A316 = 3·160+10·161+5·16² = 3·1+10·16+5·256 = 3+160+1280 = 
144310 



Задание1 : Перевести числа из десятичной системы счисления в 
шестнадцатиричную 
N вар 1 вариант 2 вариант 3 вариант 
 55,171,118,200,155,167 

 
22,11,454,34,561,45 56,455,233,245,13,27 

 
Задание2: Перевести числа из двоичной системы счисления в шестнадцатиричную 

N вар 1 вариант 2 вариант 3 вариант 
 10001,100000,1111 11111,10101,100011 11100,1000,101111 

 
Задание3: Перевести числа из десятичной системы счисления в восьмиричную 

N вар 1 вариант 2 вариант 3 вариант 
 566,245,116 344,113,352 462,312,233 
 

Контрольные вопросы: 
1 Как осуществляется перевод чисел из десятичной системы в восьмиричную? 
2 Как осуществляется перевод чисел из десятичной системы в шестнадцатиричную? 
3 Как осуществляется перевод чисел из двоичной системы в шестнадцатиричную? 
 

 
Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                  Н.А. Васянович 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Практическое занятие №7 
Тема:  Операции с числами в системах счисления 
Цель: 

1Формирование навыков и умений выполнения арифметических операций в 
двоичной системе счисления 

2 Развитие познавательного интереса, логического мышления, привитие 
навыков самостоятельности в работе. 

 
Оснащение: методические указания к практической работе №2, учебная и 

справочная литература, ПК 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
При сложении чисел в произвольной позиционной системе счисления с 

основанием р в каждом разряде производится сложение цифр слагаемых и цифры, 
переносимой из соседнего младшего разряда, если она имеется. При этом необходимо 
учитывать, что если при сложении чисел получилось число большее или равное р, то 
представляем его в виде 

 
pk + b, 

 
где k - количество единиц переноса в следующий разряд,  k € N, 

b – количество единиц в данном разряде, b € N0, 0 ≤ b ≥ p – 1, остаток от деления 
полученного числа на основание системы счисления. 

При вычитании чисел в р-ой системе счисления цифры вычитаются поразрядно. Если 
в рассматриваемом разряде необходимо от меньшего числа отнять большее, то занимается 
единица следующего (большего) разряда. Занимаемая единица равна р единицам этого 
разряда (аналогично, когда мы занимаем единицу в десятичной системе счисления, то 
занимаемая единица равна 10). 

При умножении чисел в р-ой системе счисления каждая цифра второго множителя 
умножается последовательно на цифру каждого из разрядов первого множителя. При этом 
необходимо учитывать, что если в результате умножения чисел получилось число большее 
или равное р, то представляем его в виде 

 
pk + b, 

 
где k - количество единиц переноса в следующий разряд, запоминаем и добавляем его к 
результату произведения в следующем разряде  k € N, 

b – остаток от деления полученного числа на основание системы счисления р,     b € N0, 
0 ≤ b ≥ p – 1, число b записываем в единицы данного разряда. 

Полученные результаты умножения складываем и отделяем количество знаков после 
запятой, равное сумме знаков после запятой у сомножителей.  

4.2 Рекомендации по выполнению задания 
 

Пример 1. Выполнить сложение двоичных чисел: 
А = 1011,1; В = 1101,01; С = 11101,11 

Решение 



 
Ответ: 110110,1 
Пример 2. Выполнить сложение шестнадцатеричных чисел: 
А= 5A,B; B = 9F3,C1; C= F58,F 

Решение 

 
Ответ: 14А7,61 
Пример 3. Найти разность двоичных чисел: а= 1100100,01; в= 111011,11 

Решение 

 
Ответ: 10001101,12 

Пример 4. Найти произведение восьмеричных чисел 37,27 · 4,6 
Решение 

         
Ответ: 224,7528 

 
Задания для практической работы 
 



Задание  1. Сложить числа. Проверять правильность вычислений переводом исходных 
данных и результатов в десятичную систему счисления. 
 
Т а б л и ц а  1– Варианты к заданию 1 
вариант Числа в двоичной системе 

счисления 
Числа в 
восьмеричной 
системе 
счисления 

Числа в 
шестнадцатеричной 
системе счисления 

1 10000011+1000011 356,5+1757,04 293,8+3CC,98 
2 1010010000+1101111011 1443,1+242,44 2B4,C+EA,4 
3 110010,101+1011010011,01 573,04+1577,2 108,8+21B,9 
4 1100001100+1100011001 1364,44+1040,2 158,A+34,C 
5 110010001+1001101 415,24+1345,04 113,B+65,8 
6 111111111,001+1111111110,0101 1041,2+1141,1 3А6,8+B7,5 
7 1110001000+110100100 356,25+17,04 2F3,8+3CC,98 
8 1001001101+1111000 1233,1+242,44 2B4,C+E3,4 
9 111100010,0101+1111111,01 573,04+1547,2 1B8,8+21B,9 
10 101000011+110101010 134,44+1540,2 1D8,A+324,C 
11 111010010+1011011110 467,24+135,04 153,B+165,8 
12 10011011,011+1111100001,0011 1841,2+1891,1 AC6,8+B37,5 
13 1000101101+1100000010 326,5+1357,04 23,8+3CA,98 
14 1111011010+111001100 1133,1+22,44 1B4,C+ED,4 
15 1001000011,1+10001101,101 553,04+157,2 188,8+28B,9 
16 11100000+1100000000 134,44+140,2 958,A+134,C 
17 110101101+111111110 7415,24+145,04 163,B+165,8 
18 10011011,011+1110110100,01 41,2+13141,1 13C6,8+B4,5 
19 100011+10011 346,5+1457,04 23,A+3CA,98 
20 1010010011+1101111011 1443,1+242,44 FB4,C+1ED,4 

 

Задание 2. Выполнить вычитание.  Проверять правильность вычислений переводом 
исходных данных и результатов в десятичную систему счисления. 
Т а б л и ц а  2– Варианты к заданию 2 
Вариант Числа в двоичной системе 

счисления 
Числа в 
восьмеричной 
системе счисления 

Числа в 
шестнадцатеричной 
системе счисления 

1 100111001-110110 2025,2-131,2 2D8,4-A3,B 
2 1111001110-111011010 1567,3-1125,5 416,3-255,3 
3 1101111011,01-101010,01 1300,3-464,2 37C,4-1D0,2 
4 1001101100-1000010111 1405,3-346,5 3DD,4-303,A 
5 1010001000-1000110001 1333,2-643,2 176,7-E5,4 
6 1101100110,01-1100010, 11 1621,44-1064,5 1AC,B-BD,7 
7 1010111001-1010001011 1621,4 – 131,2 3C6,8-A3,B 
8 1110101011-100111000 1064,5–125,5 B7,5-55,3 
9 1110101011-100111000 1041,2 – 464,2 1AC,B-1D,2 
10 1111111000-100010011 1141,1– 346,5 BD,7-30,A 
11 1111101110-11100110 356,5– 243,2 293,8-E5,4 
12 1001100100,01-10101001,1 1757,04 –1064,5 2F8,4-A3,B 
13 1101111100-100100010 2025,2 – 131,2 A416,3-255,3 



14 1011010110-1011001110 131,2––31,2 3B7C,4-1D0,2 
15 111101110,11-1001111,1 2001,6 – 431,2 34DD,4-303,A 
16 10110010-1010001 2125,2 –125,5 176,7-5,4 
17 1101000000-10000000 1443,1–1064,5 1AC,B-B,7 
18 11001111,1101-1001110,1 242,44–64,5 2D8,4-A,B 
19 1110011111-10010011 1567,3–864,5 416,3-25,3 
20 1100101010-11100110 1125,5–964,5 37C,4-D0,2 

 
Задание 3. Выполнить умножение.  Проверять правильность вычислений переводом 

исходных данных и результатов в десятичную систему счисления. 
 

Т а б л и ц а  3– Варианты к заданию 3 
Вариант Числа в двоичной системе счисления 

1 100111001·110110 
2 1111001110·111011010 
3 1101111011,01·101010,01 
4 1001101100·1000010111 
5 1010001000·1000110001 
6 1101100110,01·1100010, 11 
7 1010111001·1010001011 
8 1110101011·100111000 
9 1110101011·100111000 
10 1111111000·100010011 
11 1111101110·11100110 
12 1001100100,01·10101001,1 
13 1101111100·100100010 
14 1011010110·1011001110 
15 111101110,11·1001111,1 
16 10110010·1010001 
17 1101000000·10000000 
18 11001111,1101·1001110,1 
19 1110011111·10010011 
20 1100101010·11100110 

 
Контрольные вопросы для формулировки вывода 
1. Как физически можно выразить цифры 0 и 1 в двоичной системе счисления. 
2. Зачем в ЭВМ используются еще и восьмеричная и шестнадцатеричная системы 

счисления. 
3. Найти произведение чисел 238 и 1012. Результат выразить в двоичной системе 

счисления. 

Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
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Практическое занятие№8 
 

Тема: Ознакомительная работа в среде gEDA. 
Цель: 1)Сформировать практические навыки при изучении программного обеспечения 
gEDA 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР, компьютер, ПО gEDA 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Атрибуты — это пара «параметр-значение». У каждого элемента и проводника в gEDA 
есть несколько атрибутов. Редактор атрибутов вызывается двойным кликом по элементу, 
из контекстного меню — пункт «правка», или клавишами: 

 
 
Рисунок 1– окно атрибутов gEDA 
 

Основные атрибуты: 
device. Имя компонента (устройства) 
footprint. Название корпуса или его обозначение. 
refdes. Обозначение элемента в схеме. Например D1, может содержать знаки вопроса, 

как в только что вставленных компонентах, например D?. Позднее эти знаки будут 
заменены на порядковый номер элемента. 

netname. Задает имя проводника. Проводники с одинаковыми именами будут 
физически соединены при разводке. 

slot. Номер элемента в многосекционном устройстве (например, в некоторых 
микросхемах логики по нескольку одинаковых секций) 

value. Значение элемента. Используется для моделирования, но не лишне задать 
значения для резисторов, конденсаторов для отображения на схеме, например «10К», «5V» 
и т.д. 



Атрибут можно сделать видимым или невидимым, причем можно выводить только 
имя, только значение, или и то, и другое (в редакторе атрибутов колонки «Видимый», «И» 
для имени, «З» для значения). 

Для соединений можно использовать несколько вариантов: 
Проводники. Добавляются кнопкой на панели инструментов, соединяем несколько 

выводов при помощи левой кнопки мыши. Можно использовать клавишу «n». По 
умолчанию включено «магнитное соединение», то есть привязка к выводам. Ее можно 
отключить из меню «Настройка». Проводники можно редактировать, левой кнопкой 
«таская» их концы. Если у вас включено «резиновое соединение» в меню «Настройка», 
проводники не будут разрываться при перемещении элементов. 

Шины. Опять же, есть кнопка на панели или «Shift+B». Рисуем конфигурацию шины, 
после чего подключаем к ней проводники обычным способом. 

Именование. Проводники с одинаковыми именами (атрибут netname) физически 
соединяются. Поэтому проводники, подключенные к шине надо обязательно 
проименовать. 

Соединяем элементы проводниками. 
В меню «Атрибуты» выберите «Автонумеровать текст»: 

 
 
Рисунок 2– автонумерация 
 
«Автонумерация текста» - ставим «Вся иерархия», нажимаем «Применить». 
 
Следующий этап — назначение каждому элементу его посадочного места. Посадочное 

место (footprint) — это изображение элемента на печатной плате. 
Задать элементу его посадочное место можно из редактора атрибутов, добавив новый 

атрибут «footprint» с необходимым значением, или с помощью программы gattrib. 
Запустите gattrib и выберите в нем ваш файл со схемой (*****.sch). Вы увидите 

таблицу с элементами и значениями их атрибутов. Можно заполнять колонку с именем 
«footprint» и сохранять изменения (некоторые значения посадочных мест могут быть уже 
заполнены):  



 
 
Рисунок  3– Назначение элементу посадочного места 
 
Откройте затем схему в gschem и снимите видимость атрибутов «footpprint», если 

хотите, чтобы они не мешали. Для этого в меню «Атрибуты» - «Скрыть текст...», в поле 
ввода наберите «footprint=» и нажмите «Применить». 

 

 
 
Проверка схемы. 
С помощью утилиты gnetlist вы можете проверить схему на наличие некоторых 

распространенных ошибок: 
наличие непронумерованных элементов 
наличие дубликатов соединений 
наличие проводников, подключенных только одним концом 
соответствие типов соединенных выводов (для каждого вывода компонента можно 

задать его тип: вход, выход, питание и т. д. Запрещено, к примеру, подключать выход к 
другому выходу) 

наличие неподключенных выводов 
наличие дублирующихся или пустых секций в многосекционных компонентах 

 
 
 
 
 
 
 
 
 
 
 



Задание 1. Запустите программу gEDA. Постройте и проверьте схему согласно своему 
варианту 
 
N 
ва
р 

1 вариант 2 вариант 3 вариант 4 вариант 

 

 
 
Контрольные вопросы: 
 
1. Для чего предназначен редактор gEDA? 
2. Как открыть библиотеку программы? 
3. Как выбрать компонент библиотеки gEDA? 
4. Какие модули входят в состав gEDA? 
 
 
Список используемой литературы 
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учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 
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Практическое занятие№9 
 

Тема: Создание и настройка проекта в gEDA 
Цель: 1)Сформировать практические навыки при изучении программного обеспечения 
gEDA 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР, компьютер, ПО gEDA 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Электрические связи в схемах и символах gEDA отображаются с помощью выводов, 

соединений и шин.  
 Выводы используются в символах и являются представлением либо физических 

выводов электронных компонентов, либо логических соединений с подсхемой. 
 Соединения используются в схемах. Они являются представлением отдельных 

проводников, и используются для соединения между собой выводов компонентов. 
 Шины также используются в схемах, и являются представлением нескольких 

объединённых в группу соединений. 
 К соединениям, выводам и шинам могут прикрепляться атрибуты, определяющие, как 

они будут интерпретироваться программой gnetlist. 
Для добавления выводов выберите в меню Добавить→Вывод [Add→Pin]. Щёлкая 

левой кнопкой, определите позиции сначала для первого, подключаемого конца вывода, а 
затем для второго. Для завершения добавления выводов щёлкните правой кнопкой.  

 Если вывод выделить, на обоих его концах появятся ручки. Щёлкнув и потянув ручку 
левой кнопкой мыши, можно изменить положение соответствующего конца вывода. 

В gschem страницы схем и символов можно экспортировать в файлы изображений. 
Для создания файла изображения выберите Файл→Сохранить изображение… [File→Write 
image…], при этом откроется окно выбора файла изображения. В этом окне можно 
выбрать файл, в который следует сохранить изображение, формат данного файла и, если 
необходимо, его размер.  

 Если в качестве выходного формата выбрать EPS (Encapsulated Postscript), значение 
поля “Ширина x Высота” [“Width x Height”] при сохранении использоваться не будет. 

 
Задание 1. Запустите программу gEDA. Постройте и проверьте схему согласно своему 
варианту 
 
N 
ва
р 

1 вариант 2 вариант 3 вариант 4 вариант 

 

 

 

 

 
 



Контрольные вопросы: 
 
1. Для чего предназначен редактор gEDA? 
2. Как открыть библиотеку программы? 
3. Как выбрать компонент библиотеки gEDA? 
4. Какие модули входят в состав gEDA? 
 
 
Список используемой литературы 
 

1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 
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Практическое занятие№10 
 

Тема: Создание и настройка проекта в gEDA 
Цель: 1)Сформировать практические навыки при изучении программного обеспечения 
gEDA 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР, компьютер, ПО gEDA 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

Задание 1. Запустите программу gEDA. Постройте и проверьте схему согласно своему 
варианту 
 
N 
ва
р 

1 вариант 2 вариант 3 вариант 4 вариант 

 

 
 

  
 
 
Контрольные вопросы: 
 
1. Для чего предназначен редактор gEDA? 
2. Как открыть библиотеку программы? 
3. Как выбрать компонент библиотеки gEDA? 
4. Какие модули входят в состав gEDA? 
 
 
Список используемой литературы 
 

1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 
учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 
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Практическое занятие №11 
 
Тема: Способы задания Булевых функций. Минимизация Булевых функций методом 

карт Карно. 
Цель: 

1 Формирование навыков и умений выполнения минимизации Булевых 
функций методом Карно 

2 Развитие познавательного интереса, логического мышления, привитие 
навыков самостоятельности в работе. 

 
Оснащение: методические указания к практической работе №4, учебная и 

справочная литература, ПК 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Сложность схемы, реализующей булеву функцию, определяется сложностью ее 

аналитической записи. Поскольку одну и ту же булеву функцию можно представить 
различными формулами, то задача выбора наиболее простой формулы, задающей булеву 
функцию, непосредственно ведет к наиболее простой схеме, то есть, в частности, к 
экономии материалов, объема, веса и энергопотребления схемы. Минимальной формой 
булевой функции в некотором базисе можно считать такую, которая содержит 
минимальное число суперпозиций функций базиса, допуская и скобки. Однако построить 
эффективный алгоритм такой минимизации с получением минимальной скобочной 
формы трудно. 
Карта Карно 
Это двумерная табличная форма представления булевой функции, позволяющая в 

графической наглядной форме легко отыскать минимальные ДНФ логических функций. 
Каждой клетке в таблице сопоставляется терм СДНФ минимизируемой функции, причем 
так, что любым осям симметрии таблицы соответсвуют зоны, взаимно инверсные по 
какой-либо переменной. Такое расположение клеток в таблице позволяет легко 
определить склеивающиеся термы СДНФ (отличающиеся знаком инверсии только одной 
переменной): они располагаются в таблице симметрично.  

 
Пример.     Минимизировать с помощью карт Карио ЛФ. 
 

 
 
Исходная функция будет иметь вид: 

 

 
 
 

 
 

 
 
Минимизированную функцию образуем из 5 импликант  



 

 
 
На практике бывает так, что функция на некоторых наборах не определена по 

некоторым причинам (запрещенные входные комбинации, безразличные и т.п.). Такие 
функции называются полностью определенными. Карты Карно позволяют доопределить 
эти функции наилучшим образом. 

 
Задание 1. Выполните задания, согласно варианту. Минимизировать логические 

функции 4 переменных. 
 

N 
вар 

1 вариант 2 вариант 3 вариант 4 вариант 

  
 

  

Задание 2. Минимизировать неполностью определенные функции: 

 
 

 
 

 
 
Контрольные вопросы: 
 
1. Дайте определение логической функции 
2. Как может быть представлена Булева функция 
 
Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 
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Практическое занятие №12 
Тема: Моделирование цифровых устройств комбинационного типа 

     Цель: 
1 Формирование навыков и умений выполнения моделирования цифровых устройств комбинационного типа  
2 Развитие познавательного интереса, логического мышления, привитие навыков самостоятельности в работе. 

 
Оснащение: методические указания к практической работе №5, учебная и справочная литература, ПК 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

Под комбинационным цифровым устройством (КЦУ) понимается цифровое устройство, обеспечивающее преобразование 
совокупности N входных цифровых сигналов в M выходных, при этом состояние выходных сигналов в данный момент времени определяется 
состоянием входных сигналов в этот же момент времени. Иными словами, КЦУ «не помнит» предыстории поступления сигналов на его 
входы. Правила функционирования КЦУ определяются реализуемыми ими функциями алгебры логики. 

Реализация КЦУ предполагает выбор определенных логических элементов из заданного набора и их соединение таким образом, 
чтобы обеспечивалась зависимость цифровых выходных сигналов от входных с заданными правилами функционирования. При реализации 
КЦУ широко используются интегральные комбинационные логические микросхемы малой степени интеграции, образующие основу 
элементной базы цифровой электроники. В настоящее время, как в нашей стране, так и за рубежом, выпускается широкая номенклатура 
комбинационных микросхем малой степени интеграции ТТЛ-, ЭСЛ- и КМОП-типов. При выборе конкретной микросхемы необходимо 
руководствоваться видом реализуемой ею логической функции, быстродействием, нагрузочной способностью и возможностью 
совместимости электрических характеристик входных и выходных сигналов с остальными элементами схемы. 

Перечислим в качестве примера некоторые стандартные буквенные обозначения, записываемые в маркировке микросхем 
комбинационного типа малой степени интеграции и определяющие выполняемые ими функции: ЛА обозначает функцию И-НЕ; ЛЕ - 
функцию ИЛИ-НЕ; ЛИ – функцию И; ЛЛ - функцию ИЛИ; ЛР – функцию И-ИЛИ-НЕ; ЛН – функцию НЕ; ЛП – функцию повторителя. 
Микросхемы со стандартными выходными электрическими параметрами не сопровождаются в своих условных графических обозначениях 
(УГО) какими-либо дополнительными признаками. Если выходы микросхем имеют повышенную нагрузочную способность, то в УГО таких 
микросхем рядом с соответствующими выводами или группой выводов проставляется знак «». Часто выходы микросхем ТТЛ-типа 
выполняют с открытыми коллекторами, о чем свидетельствует обозначение «» в УГО микросхемы. Это позволяет задавать выходные 
напряжения логической единицы больше стандартных значений при помощи так называемых подтягивающих резисторов или иных цепей, 
подключающих выходы этих микросхем к источнику напряжения необходимого уровня. К таким выводам можно, например, напрямую 
подключать индикаторы различных типов или осуществлять преобразование уровней ТТЛ в иные. 

 
Задание 1. Исследовать схему цифрового устройства комбинационного типа, описать принцип ее работы 
 

Nва
р 

1 вариант (одноразрядный сумматор) 2 вариант (многоразрядный сумматор) 

 

 
Контрольные вопросы 
 
1Перечислить основные законы булевой алгебры. Какой закон описывает формула де Моргана? 
2С какой целью проводится минимизация логических функций. 
3В чем вы видите достоинства представления чисел со знаком в дополнительном коде? Запишите результат сложения дополнительных 

кодов чисел плюс 80 и минус 33. Каждое число отображается байтом. 
4Какие коды может сравнивать цифровой компаратор? Запишите возможные варианты функций сравнения. 

 
Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : учебник для студентов учреждений среднего 

профессионального образования. Издательство: Академия, Год издания: 2016 
 
Составил преподаватель                                                  Н.А. Васянович 

 



 

 
 
 
 
 
 
 
 
 

Практическое занятие №13 
Тема: Моделирование цифровых устройств последовательного типа 
 
Цель: 

1 Формирование навыков и умений выполнения моделирования цифровых 
устройств последовательного типа  

2 Развитие познавательного интереса, логического мышления, привитие 
навыков самостоятельности в работе. 

 
Оснащение: методические указания к практической работе №5, учебная и 

справочная литература, ПК 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Все цифровые устройства (ЦУ) принято разбивать на два класса: комбинационные ЦУ 

(КЦУ) и последовательностные ЦУ (ПЦУ). 
Отличительные особенности этих классов ЦУ состоят в следующем. Для КЦУ значения 

выходных переменных в некоторый момент времени определяются только значениями 
входных переменных в тот же момент времени. Для ПЦУ значения выходных переменных 
определяются не только входными переменными в данный момент, но и их значениями в 
предшествующие моменты времени. Примером, поясняющим принцип работы ПЦУ, 
является телефон. Чтобы соединиться с определенным абонентом, следует набрать 
последовательность цифр, соответствующую его номеру. Произойдет ли подключение к 
нужному абоненту, когда набирается последняя цифра, зависит как от этой цифры, так и от 
ранее набранной комбинации цифр. 
Изменения значений входных переменных ЦУ происходят дискретно во времени. При 

этом временные интервалы, в течение которых эти значения сохраняются неизменными, 
называют тактами работы ЦУ. 
ПЦУ – это цифровой преобразователь информации, способный принимать различные 

состояния, хранить (сохранять) их, переходить под воздействием входных сигналов из 
одного состояния в другое и формировать выходные сигналы. 



 
 
 
Р и с у н о к  1 –  Классификация триггеров 
 
Триггеры являются простейшими ПЦУ. Классификация триггеров может 

осуществляться по ряду признаков. Основным из них является признак логического 
функционирования, при использовании которого триггеры разделяют по виду 
характеристического уравнения (так применительно к триггерам называется уравнение 
переходов) 

 
Задание1. Исследовать схему цифрового устройства последовательного типа, описать 

принцип ее работы 
 

Nва
р 

1 вариант (Параллельный регистр 
памяти) 

2 вариант (Регистр сдвига вправо) 

 

 

 
 
Контрольные вопросы 
 
1Перечислить основные законы булевой алгебры.  
2С какой целью проводится минимизация логических функций. 
3В чем вы видите достоинства представления чисел со знаком в дополнительном коде? 

Запишите результат сложения дополнительных кодов чисел плюс 90 и минус 21. Каждое 
число отображается байтом. 

 
Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                  Н.А. Васянович 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Практическое занятие № 14 
Тема: Моделирование работы RS-триггеров 
Цель: 1)Сформировать практические навыки при исследовании работы RS-триггера. 
           2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР, схема 
 

Порядок выполнения работы 
Краткие теоретические сведения 

 
RS-триггер получил название по названию своих входов. Вход S (Set – установить 

англ.) позволяет устанавливать выход триггера Q в единичное состояние. Вход R (Reset – 
сбросить англ.) позволяет сбрасывать выход триггера Q (Quit – выход англ.) в нулевое 
состояние. 

Для реализации RS-триггера воспользуемся логическими элементами “2И-НЕ”. Его 
принципиальная схема приведена на рисунке 

 
Р и с у н о к  1  - Схема простейшего триггера на схемах "И". Входы R и S инверсные 

(активный уровень'0'). 
 
Рассмотрим работу изображенной на рисунке 2 схемы подробнее. Пусть на входы R и 

S подаются единичные потенциалы. Если на выходе верхнего логического элемента “2И-
НЕ” Q присутствует логический ноль, то на выходе нижнего логического элемента “2И-
НЕ” появится логическая единица. Эта единица подтвердит логический ноль на выходе Q. 
Если на выходе верхнего логического элемента “2И-НЕ” Q первоначально присутствует 
логическая единица, то на выходе нижнего логического элемента “2И-НЕ” появится 
логический ноль. Этот ноль подтвердит логическую единицу на выходе Q. То есть при 



единичных входных уровнях схема RS-триггера работает точно так же как и схема на 
инверторах. 

Подадим на вход S нулевой потенциал. Согласно таблице истинности логического 
элемента “И-НЕ” на выходе Q появится единичный потенциал. Это приведёт к появлению 
на инверсном выходе триггера нулевого потенциала. Теперь, даже если снять нулевой 
потенциал с входа S, на выходе триггера останется единичный потенциал. То есть мы 
записали в триггер логическую единицу. 

Точно так же можно записать в триггер и логический ноль. Для этого следует 
воспользоваться входом R. Так как активный уровень на входах оказался нулевым, то эти 
входы - инверсные. Составим таблицу истинности RS-триггера. Входы R и S в этой 
таблице будем использовать прямые, то есть запись нуля, и запись единицы будут 
осуществляться единичными потенциалами. RS-триггер можно построить и на логических 
элементах "ИЛИ". Схема RS-триггера, построенного на логических элементах "ИЛИ" 
приведена на рисунке 3. Единственное отличие в работе этой схемы будет заключаться в 
том, что сброс и установка триггера будет производиться единичными логическими 
уровнями. 

 

 
Р и с у н о к  2  -  Схема простейшего триггера на схемах "ИЛИ". Входы R и S прямые 

(активный уровень '1'). 
 
Так как RS-триггер при построении его на логических элементах “И” и “ИЛИ” 

работает одинаково, то его изображение на принципиальных схемах тоже одинаково. 
Условно-графическое изображение RS-триггера на принципиальных схемах приведено на 
рисунке 

 
Р и с у н о к  3  -   Условно-графическое обозначение RS-триггера. 

 
Задание1: Обозначить элементы на схемах триггера 

N вар 1 вариант 2 вариант 
 

  
 



Контрольные вопросы: 
1. Дать определение триггеру. 
2. Построить схему триггера, обозначив все функциональные узлы 

 
Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                  Н.А. Васянович 

 
 
 
 
 
 

 
Практическое занятие №15 

Тема: Моделирование JK-триггеров 
Цель: 1)Сформировать практические навыки при исследовании работы JK-триггера. 

                 2) развивать интерес к изучаемой дисциплине 
 
Оснащение: МУ к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Триггерами или, точнее, триггерными системами называют большой класс 

электронных устройств, обладающих способностью длительно находиться в одном из двух 
или более устойчивых состояний и чередовать их под воздействием внешних сигналов. 
Каждое состояние триггера легко распознаётся по значению выходного напряжения. По 
характеру действия триггеры относятся к импульсным устройствам — их активные 
элементы (транзисторы, лампы) работают в ключевом режиме, а смена состояний длится 
очень короткое время. 

JK-триггер работает так же как RS-триггер, с одним лишь исключением: при подаче 
логической единицы на оба входа J и K состояние выхода триггера изменяется на 
противоположное. Вход J (от англ. Jump — прыжок) аналогичен входу S у RS-триггера. 
Вход K  аналогичен входу R у RS-триггера. При подаче единицы на вход J и нуля на вход 
K выходное состояние триггера становится равным логической единице. А при подаче 
единицы на вход K и нуля на вход J выходное состояние триггера становится равным 
логическому нулю. JK-триггер в отличие от RS-триггера не имеет запрещённых состояний 
на основных входах, однако это никак не помогает при нарушении правил разработки 
логических схем. На практике применяются только синхронные JK-триггеры, то есть 
состояния основных входов J и K учитываются только в момент тактирования, например 
по положительному фронту импульса на входе синхронизации. 

На базе JK-триггера возможно построить D-триггер или Т-триггер. Как можно видеть 
в таблице истинности JK-триггера, он переходит в инверсное состояние каждый раз при 
одновременной подаче на входы J и K логической 1. Это свойство позволяет создать на 
базе JK-триггера Т-триггер, объединив входы J и К. 



 

 
 
Р и с у н о к  1  -  Символ JK-триггера с дополнительными асинхронными входами S и 

R 

 
Р и с у н о к  2 -  JK-триггер 
 
Для реализации счетного режима в схеме, приведенной на рисунке, введена 

перекрестная обратная связь с выходов второго триггера на входы R и S первого триггера. 
Благодаря этой обратной связи на входах R и S никогда не может возникнуть запрещенная 
комбинация. 

 
Задание: Обозначить элементы на схемах триггера 

N 
вар 

1 вариант 2 вариант 

 

 

 
Контрольные вопросы: 
1. Дать определение триггеру. 
2. Построить схему триггера, обозначив все функциональные узлы 

 
Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 



Составил преподаватель                                                  Н.А. Васянович 
 
 
 

 
 
 
 
 
 
 
 
 

Практическое занятие№16 
Тема: Моделирование счетчиков 
Цель: 1)Сформировать практические навыки при изучении схем счетчиков, режима их 

работы 
                 2) развивать интерес к изучаемой дисциплине 

 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Счётчики используются для построения таймеров или для выборки инструкций из ПЗУ 

в микропроцессорах. Они могут использоваться как делители частоты в управляемых 
генераторах частоты (синтезаторах). При использовании в цепи ФАП счётчики могут быть 
использованы для умножения частоты как в синтезаторах, так и в микропроцессорах. 
Счетчик - цифровое устройство, осуществляющее счет числа появлений на входе 

определенного логического уровня. В дальнейшем во всех случаях, когда это не 
оговаривается специально, будем полагать, что счетчик производит подсчет числа 
содержащихся во входном сигнале переходов с уровня лог. 0 к уровню лог. 1. При 
импульсном представлении логических переменных уровню лог. 1 соответствует импульс, 
и счетчик ведет счет поступающих на вход импульсов. 
В суммирующем счетчике поступление на вход очередного уровня лог. 1 (очередного 

импульса) вызывает увеличение на одну единицу хранимого в счетчике числа. Таким 
образом, в счетчике устанавливается число, которое получается путем суммирования 
предыдущего значения с единицей. Это суммирование проводится по обычным правилам 
выполнения операций сложения в двоичной системе счисления. 
В вычитающем счетчике поступление на вход очередной лог. 1 (очередного импульса) 

вызывает уменьшение хранившегося в счетчике числа на единицу. 
 
Задание1. Постройте схему счетчика, обозначив все функциональные узлы  

Nвар 1вариант 



 

 
 2 вариант 

 

 
 

Контрольные вопросы: 
 
1. Дайте определение счетчику 
2 В каких устройствах используется счетчики? 
3.Постройте схему счетчика. Какие основные модули входят в схему? 
 
 
Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                  Н.А. Васянович 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Практическое занятие №17 
Тема: Моделирование сдвигающих регистров и устройств на их основе 
Цель: 1)Сформировать практические навыки при изучении схем сдвигающих 

регистров, режима их работы 
                 2) развивать интерес к изучаемой дисциплине 

 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Кроме операции хранения данных регистры могут использоваться и для операции 

сдвига данных с целью преобразования двоичного последовательного кода в 
параллельный и наоборот. Это так называемые сдвиговые регистры или регистры сдвига, 
которые получаются путем цепочного соединения триггеров. 
Суть сдвига состоит в том, что по сигналу синхроимпульса происходит одновременная 

перезапись содержимого каждого триггера в соседний триггер. При этом не меняется само 
двоичное слово (число), записанное в регистре, оно лишь сдвигается на один разряд и 
только содержимое последнего триггера ТТ3 пропадает из регистра, а на вход первого ТТ0 
поступает новый бит 

 
 
Р и с у н о к  1  – Сдвигающий регистр 
 



Сдвигающий регистр в отличие от регистра памяти должен обязательно состоять из 
непрозрачных триггеров, иначе при первом же сигнале сдвига бит, поступивший на вход 
первого триггера регистра сдвига, сразу же пройдёт на выход этого триггера и 
соответственно, на вход второго триггера, а значит и на выход второго триггера и т. д. до 
последнего триггера регистра сдвига. 
В некоторых сдвиговых регистрах сдвиг происходит не только в одну сторону, а и 

влево и вправо - это так называемые реверсивные регистры. 
Чтобы обеспечить реверс сдвига и параллельную запись сразу во все триггеры к D-

входу каждого i-того триггера подключён мультиплексор, который при подаче " 1 " на 
один из управляющих входов - SL(Shift Left - сдвиг влево), SR(Shift Right - сдвиг вправо) 
или PL(Parallel load - параллельная загрузка) подключает вход i-того триггера 
соответственно к выходу младшего соседа (направление A), старшего соседа (направление 
B) или к выходу параллельной загрузки Di (см. рис.2). Точка A самого младшего триггера 
(разряда) является входом DR, точка В самого старшего разряда - входом DL (входы DL и 
DR используются для наращивания разрядности реверсивных регистров). Выход i-го 
триггера подключён к соответствующим входам мультиплексоров соседних разрядов. По 
С-сигналу триггеры регистра принимают информацию с направлений, диктуемых 
мультиплексорами. 

 
Задание1. Построить схему регистра согласно варианту, определить тип регистра 

описать принцип ее работы. 
N 
ва
р 

1 вариант 2 вариант 

 

  

N 
ва
р 

3 вариант 4 вариант 

 

 

 
 
 
Контрольные вопросы: 
 
1. Дайте определение регистру 
2 В каких устройствах используется регистры сдвига? 



3.Постройте схему регистра. Какие основные модули входят в схему? 
 
 
Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                  Н.А. Васянович 

 
 
 
 
 
 
 
 
 

Практическое занятие№18 
 

Тема: Моделирование многокаскадных цифровых устройств 
Цель: 1)Сформировать практические навыки при изучении программного обеспечения 
gEDA 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР, компьютер, ПО gEDA 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
Каскады усиления 
Каскад усиления — ступень усилителя, содержащая один или несколько 

усилительных элементов, цепи нагрузки и связи с предыдущими или последующими 
ступенями. 

В качестве усилительных элементов обычно используются электронные лампы или 
транзисторы (биполярные, полевые), иногда, в некоторых специальных случаях, могут 
применяться и двухполюсники, например, туннельные диоды (используется свойство 
отрицательного сопротивления) и др. Полупроводниковые усилительные элементы (а 
иногда и вакуумные) могут быть не только дискретными (отдельными) но и 
интегральными (в составе микросхем), часто в одной микросхеме реализуется полностью 
законченный усилитель. 

В зависимости от способа включения усилительного элемента различаются каскады с 
общей базой, общим эмиттером, общим коллектором (эмиттерный повторитель) (у 
биполярного транзистора), с общим затвором, общим истоком, общим стоком (истоковый 
повторитель) (у полевого транзистора) и с общей сеткой, общим катодом, общим анодом 
(у ламп)  

Каскад с общим эмиттером (истоком, катодом) — наиболее распространённый способ 
включения, позволяет усиливать сигнал по току и напряжению одновременно, сдвигает 
фазу на 180°, то есть является инвертирующим. 

Каскад с общей базой (затвором, сеткой) — усиливает только по напряжению, 
применяется редко, является наиболее высокочастотным, фазу не сдвигает. 



Каскад с общим коллектором (стоком, анодом) — называется также повторителем 
(эмиттерным, истоковым, катодным), усиливает ток, оставляя напряжение сигнала равным 
исходному. Применяется в качестве буферного усилителя. Важными свойствами 
повторителя являются его высокое входное и низкое выходное сопротивления, фазу не 
сдвигает. 

Каскад с распределенной нагрузкой — каскад, занимающий промежуточное 
положение между схемой включения с общим эмиттером и общим коллектором. Как 
вариант каскада с распределенной нагрузкой, выходной каскад усилителя мощности 
«двухподвес». Важными свойствами являются задаваемый элементами схемы 
фиксированный коэффициент усиления по напряжению и низкие нелинейные искажения. 
Выходной сигнал дифференциальный. 

Каскодный усилитель — усилитель, содержащий два активных элемента, первый из 
которых включен по схеме с общим эмиттером (истоком, катодом), а второй — по схеме с 
общей базой (затвором, сеткой). Каскодный усилитель обладает повышенной 
стабильностью работы и малой входной ёмкостью. Название усилителя произошло от 
словосочетания «КАСКад через катОД» (англ. CASCade to cathODE)[1] 

Каскады усиления могут быть однотактными и двухтактными.  
Однотактный усилитель — усилитель, в котором входной сигнал поступает во 

входную цепь одного усилительного элемента или одной группы элементов, соединённых 
параллельно. 

Двухтактный усилитель — усилитель, в котором входной сигнал поступает 
одновременно во входные цепи двух усилительных элементов или двух групп 
усилительных элементов, соединённых параллельно, со сдвигом по фазе на 180°. 
 
Задание 1. Запустите программу gEDA. Постройте и проверьте схему многокаскадного 
цифрового устройства согласно своему варианту 
 
N 
ва
р 

1 вариант 2 вариант 

 

 
 

 3 вариант 4 вариант 
 

 

 



 
Контрольные вопросы: 
 
1. Для чего предназначен редактор gEDA? 
2. Как открыть библиотеку программы? 
3. Как выбрать компонент библиотеки gEDA? 
4. Какие модули входят в состав gEDA? 
 
Список используемой литературы 

1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 
учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

Составил преподаватель                                                Васянович Н.А 
 

 

 

Практическое занятие №19 

          Тема: Моделирование работы АЦП 
Цель: 1)Получить практические навыки по изучению требований, предъявляемых к 

АЦП 
           2) развивать интерес к изучаемой дисциплине 

Оснащение: методические указания к практической работе, компьютер 

 

Ход работы 

Теоретическое обоснование 

Аналого-цифровой преобразователь (АЦП, англ. Analog-to-digital converter, ADC) — 
устройство, преобразующее входной аналоговый сигнал в дискретный код (цифровой 
сигнал). Обратное преобразование осуществляется при помощи ЦАП (цифро-аналогового 
преобразователя, DAC). 

Как правило, АЦП — электронное устройство, преобразующее напряжение в 
двоичный цифровой код. Тем не менее, некоторые неэлектронные устройства с цифровым 
выходом, следует также относить к АЦП, например, некоторые типы преобразователей 
угол-код. Простейшим одноразрядным двоичным АЦП является компаратор. 

 

Задание 

Дайте определение  

Nвар 1 2 3 4 

 АЦП с 
промежуточ
ным 
преобразова
нием 

АЦП с 
уравновешиван
ием заряда 

АЦП сравнения с 
пилообразным 
сигналом 

АЦП 
дифференциального 
кодирования 

 



Контрольные вопросы: 

1. Дайте классификацию АЦП 
2. В чем отличие ЦАП от АЦП? 
Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                  Н.А. Васянович 

 

 

 

 

 

Практическое занятие№20 

          Тема: Моделирование работы ЦАП 
Цель: 1)Получить практические навыки по изучению требований, предъявляемых к 

ЦАП 
           2) развивать интерес к изучаемой дисциплине 

Оснащение: методические указания к практической работе, компьютер 

 

Ход работы 

Теоретическое обоснование 

Цифро-аналоговый преобразователь (ЦАП) — устройство для преобразования 
цифрового (обычно двоичного) кода в аналоговый сигнал (ток, напряжение или заряд). 
Цифро-аналоговые преобразователи являются интерфейсом между дискретным цифровым 
миром и аналоговыми сигналами. 

Аналого-цифровой преобразователь (АЦП) производит обратную операцию. 
Звуковой ЦАП обычно получает на вход цифровой сигнал в импульсно-кодовой 

модуляции (англ. PCM, pulse-code modulation). Задача преобразования различных сжатых 
форматов в PCM выполняется соответствующими кодеками. 
 

Задание 

Дайте определение  

Nвар 1 2 3 4 

 Широтно-
импульсны
й 
модулятор  

ЦАП 
передискретиза
ции, 

ЦАП 
взвешивающего 
типа 

ЦАП лестничного типа 
( 

 

Контрольные вопросы: 



1. Дайте классификацию ЦАП 
2. В чем отличие ЦАП от АЦП? 

 

Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                  Н.А. Васянович 

 
 
 
 
 
 

 
Практическое занятие №1 

 
Тема: Организация рабочего места с учетом требований органов технического надзора. 
Оказание первой доврачебной помощи при различных видах травм. 
 
Цель: 1)Сформировать практические навыки при изучении доврачебной помощи при 
различных видах травм. 
 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

Рабочие места обжига изоляции с концов электропроводов (жгутов) должны быть 
оборудованы местной вытяжной вентиляцией. Работа по обжигу изоляции без применения 
работниками защитных очков не допускается. Для местного освещения рабочих мест при 
пайке паяльником должны применяться светильники с непросвечивающими 
отражателями. Светильники должны располагаться таким образом, чтобы их светящие 
элементы не попадали в поле зрения работников. На участках приготовления флюсов 
должны быть водопроводный кран с раковиной и нейтрализующие жидкости для удаления 
паяльных флюсов, содержащих фтористые и хлористые соли, в случаях их попадания на 
кожу работника. Рабочие поверхности столов и оборудования на участках пайки 
паяльником, а также поверхности ящиков для хранения инструментов должны 
покрываться гладким, легко очищаемым и обмываемым материалом. 

При пайке паяльником на работника могут воздействовать опасные и вредные 
производственные факторы: 

-повышенная загазованность воздуха рабочей зоны парами вредных -химических 
веществ; 

-повышенная температура поверхности изделия, оборудования, инструмента и 
расплавов припоев; 

-повышенная температура воздуха рабочей зоны; 



-пожароопасность; 
-брызги припоев и флюсов; 
-повышенное значение напряжения в электрической цепи, замыкание которой может 

произойти через тело работника. 
Пайку паяльником в замкнутых объемах проводить не менее чем двум работникам. 

Для осуществления контроля безопасного проведения работ один из работников должен 
находиться вне замкнутого объема. Работник, находящийся в замкнутом объеме, кроме 
спецодежды должен применять: защитные каски (полиэтиленовые, текстолитовые или 
винипластовые), электрозащитные средства (диэлектрические перчатки, галоши, коврики) 
и предохранительный пояс с канатом, конец которого должен находиться у наблюдающего 
вне замкнутого объема. 

При возникновении пожара: 
прекратить работу; 
отключить электрооборудование; 
сообщить непосредственному или вышестоящему руководителю о пожаре; 
сообщить о пожаре в пожарную охрану; 
принять по возможности меры по эвакуации работников, тушению пожара и 

сохранности материальных ценностей. 
Меры первой помощи пострадавшему от электрического тока.  
 Меры первой помощи зависят от состояния, в котором находится пострадавший 

после освобождения его от электрического тока.  
 Для определения этого состояния необходимо немедленно произвести следующие 

мероприятия:  
 • уложить пострадавшего на спину на твердую поверхность;  
 • проверить наличие у пострадавшего дыхания (определяется по подъему грудной 

клетки или каким-либо другим способом);  
 • проверить наличие у пострадавшего пульса на лучевой артерий у запястья или на 

сонной артерии на переднебоковой поверхности шеи;  
 • выяснить состояние зрачка (узкий или широкий); широкий зрачок указывает на 

резкое ухудшение кровоснабжения мозга.  
 Во всех случаях поражения электрическим током вызов врача является обязательным 

независимо от состояния пострадавшего.  
 Если пострадавший находится в сознании, но до этого был в состоянии обморока, его 

следует уложить в удобное положение (подстелить под него и накрыть его сверху чем-
либо из одежды) и до прибытия врача обеспечить полный покой, непрерывно наблюдая за 
дыханием и пульсом. Ни в коем случае нельзя позволять пострадавшему двигаться, а тем 
более продолжать работу, так как отсутствие тяжелых симптомов после поражения 
электрическим током не исключает возможности последующего ухудшения состояния 
пострадавшего. Если врача быстро вызвать невозможно, необходимо срочно доставить 
пострадавшего в медицинский пункт, обеспечив для этого необходимые транспортные 
средства или носилки.  

 Если пострадавший находится в бессознательном состоянии, но с сохранившимся 
устойчивым дыханием и пульсом, его следует ровно и удобно уложить, распустить и 
расстегнуть одежду, создать приток свежего воздуха, давать нюхать нашатырный спирт, 
обрызгивать его водой и обеспечить полный покой и постоянное наблюдение. 
Одновременно следует срочно вызвать врача. Если пострадавший плохо дышит – очень 
редко и судорожно (как умирающий), ему следует делать искусственное дыхание и массаж 
сердца.  

 При отсутствии у пострадавшего признаков жизни (дыхания и пульса) нельзя считать 
его мертвым, так как смерть часто бывает лишь кажущейся. В таком состояний 



пострадавший, если ему не будет оказана немедленная первая помощь в виде 
искусственного дыхания и наружного (непрямого) массажа сердца, действительно умрет. 
Искусственное дыхание следует производить непрерывно, как до, так и после прибытия 
врача. Вопрос о целесообразности или бесцельности дальнейшего проведения 
искусственного дыхания решается врачом.  

 При оказании помощи мнимоумершему бывает дорога каждая ее секунда, поэтому 
первую помощь следует оказывать немедленно и по возможности на месте происшествия. 
Переносить пострадавшего в другое место следует только в тех случаях, когда ему или 
лицу, оказывающему помощь, продолжает угрожать опасность или когда оказание помощи 
на месте невозможно.  

 Пораженного электрическим током можно признать мертвым только в случае 
наличия видимых тяжелых внешних повреждений, например в случае раздробления черепа 
при падении или при обгорании всего тела. В других случаях констатировать смерть имеет 
право только врач. 

 
 

 
Задание 1: Ответьте на вопросы согласно варианту 

N вар 1 вариант 2 вариант 3 вариант 
 Как оказать помощь 

при поражении 
током? 

Дайте характеристику 
рабочего места при 
травлении печатной 
платы 

Составьте 
инструкцию о 
порядке работы с 
паяльником 

 
Контрольные вопросы: 
 
1. Как оказать помощь при поражении током? 
2. Дайте характеристику рабочего места при травлении печатной платы. 
3. Составьте инструкцию о порядке работы с паяльником. 
 
Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                  Н.А. Васянович 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Практическое занятие№2 
 

Тема: Моделирование цифровых схем в программе gEDA 
Цель: 1)Сформировать практические навыки при изучении программного обеспечения 
gEDA 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР, компьютер, ПО gEDA 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
 
Задание 1. Запустите программу gEDA. Постройте и проверьте схему согласно своему 
варианту 
 
N 
ва
р 

1 вариант 2 вариант 

 

 

 
 3 вариант 4 вариант 



 

 

 
 
 
Контрольные вопросы: 
 
1. Для чего предназначен редактор gEDA? 
2. Как открыть библиотеку программы? 
3. Как выбрать компонент библиотеки gEDA? 
4. Какие модули входят в состав gEDA? 
 
 
Список используемой литературы 
 

1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 
учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

Составил преподаватель                                                Васянович Н.А 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Практическое занятие№3 
 

Тема: Моделирование цифровых схем в программе gEDA 
Цель: 1)Сформировать практические навыки при изучении программного обеспечения 
gEDA 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР, компьютер, ПО gEDA 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Задание 1. Запустите программу gEDA. Постройте и проверьте схему согласно своему 
варианту 
 
N 
ва
р 

1 вариант 2 вариант 



 

 

 
 3 вариант 4 вариант 
 

 

 
 
 
Контрольные вопросы: 
1. Для чего предназначен редактор gEDA? 
2. Как открыть библиотеку программы? 
3. Как выбрать компонент библиотеки gEDA? 
4. Какие модули входят в состав gEDA? 
 
Список используемой литературы 
 

1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 
учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                Васянович Н.А 

 
 
 

 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Практическая работа №4 
 

Тема: Исследование микросхем комбинационного типа малой интеграции 
 
Цель: 1)Сформировать практические навыки при исследовании микросхем 
комбинационного типа малой интеграции 
 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Существует много типов микросхем ТТЛ малой степени интеграции, 

различающихся по функциональному назначению, нагрузочной способности, схеме 
выходного каскада. Работа логических элементов этих микросхем достаточно проста. Для 
элементов И выходной уровень лог. 1 формируется при подаче на все входы элемента 



уровней лог. 1, для элемента ИЛИ для формирования уровня лог. 1 на выходе достаточно 
подачи хотя бы на один вход уровня лог. 1. Элементы И-НЕ (основной элемент серий ТТЛ) 
и ИЛИ-НЕ дополнительно инвертируют выходной сигнал, элемент И-ИЛИ-НЕ состоит из 
нескольких элементов И, выходы которых подключены к входам элемента ИЛИ-НЕ. 

По нагрузочной способности микросхемы можно разделить на стандартные (╧10 для 
серий К 155 и КР531 и N = 20 и 40 для микросхем серий К555 и КР1533 соответственно), 
микросхемы с повышенной нагрузочной способностью (N = 30 и более), микросхемы со 
специальным выходным каскадом, обеспечивающим значительно более высокую 
нагрузочную способность в одном из логических состояний. Некоторые типы микросхем 
выпускают с так называемым <открытым> коллекторным выходом. 
 

Задание1: Постройте схему, обозначьте на схеме все элементы, опишите принцип ее 
работы 

 
N 
ва

р 

1 вариант 2 вариант 3 вариант 

 

 

 
 

 
 
Контрольные вопросы: 
 
4. Какие схемы относят к микросхемам малой интеграции? 
5. Приведите пример микросхем малой интеграции. 
6. Как реализуются микросхемы И, ИЛИ, НЕ? 
 
Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                Васянович Н.А 

 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Практическое  занятие №5 
 

Тема: Исследование синтеза комбинационного цифрового устройства с одним выходом 
 
Цель: 1)Сформировать практические навыки при исследовании синтеза комбинационного 
цифрового устройства с одним выходом 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

Синтез КЦУ предусматривает построение структурной схемы устройства, т.е. 
определение состава необходимых логических элементов и соединений между ними, при 
которых обеспечивается преобразование входных цифровых сигналов в выходные в 
соответствии с заданными условиями работы устройства. В процессе синтеза обычно 
подразумевается необходимость минимизации аппаратных затрат на реализацию 



устройства. Рассмотрим синтез КЦУ с одним выходом. Последовательность синтеза 
целесообразно разбить на ряд этапов:  

запись условий функционирования КЦУ в виде таблиц истинности, логической 
функции, последовательности десятичных чисел или кубического комплекса; 

запись и минимизация СДНФ или СКНФ; 
запись минимизированной структурной формулы и ее преобразование с помощью 

законов и тождеств алгебры логики в заданном базисе, обычно И-НЕ, ИЛИ-НЕ, И-ИЛИ-
НЕ; 

оставление структурной схемы КЦУ, т.е. изображение нужных логических 
элементов и связей между ними.  

Проиллюстрируем пример синтеза КЦУ на элементах И-НЕ для реализации 
логической функции, заданной в виде десятичных цифр 

 
 
Структурная формула в СДНФ имеет вид 

 
 
После выполнения процесса минимизации методами, рассмотренными в теме 1, 

получим МДНФ 
 

 
Для перехода к заданному базису И-НЕ поставим два знака инверсии над правой 

частью формулы и применим к ней правило де Моргана. В результате получим 
структурную формулу в следующем виде: 

 

 
 
Рисунок 1 – Пример синтеза комбинационного устройства 
 
Задание1: Постройте схему, обозначьте на схеме все элементы, опишите принцип ее 

работы 
 

N 
ва

р 

1 вариант 2 вариант 3 вариант 



 

 
 

 

 
 
Контрольные вопросы: 
 
1. Какие схемы относят к комбинационным устройствам? 
2. Приведите пример комбинационного цифрового устройства с одним выходом 
3. Как реализуются микросхемы комбинационных устройств? 
 
Список литературы: 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                Васянович Н.А 

 
 
 
 
 
 

Практическое занятие №6 

Тема: Исследование работы сумматора 
Цель: 1)Получить практические навыки по изучению требований, предъявляемых к 

сумматорам 
           2) развивать интерес к изучаемой дисциплине 

Оснащение: методические указания к практической работе, компьютер 

Ход работы 
Теоретическое обоснование 

 

Сумматор — логический операционный узел, выполняющий арифметическое 
сложение двоичных, троичных или n-ичных кодов двух (бинарный), трёх (тринарный) или 
n чисел (n-нарный). При арифметическом сложении выполняются и другие 
дополнительные операции: учёт знаков чисел, выравнивание порядков слагаемых и тому 
подобное. 



Сумматоры являются комбинационными схемами, выполняющими бинарную 
(двухоперандные), тринарную (трёхоперандные) или n-арную (n-операндную) логическую 
функцию сложения. Входят в состав узлов арифметическо-логических устройств (АЛУ). 

Основным узлом АЛУ, входящего в состав операционного устройства, является 
сумматор - логический элемент, реализующий алгебраическое сложение двух чисел. 

При сложении двух чисел независимо от системы счисления в каждом разряде 
производится сложение трёх цифр: цифры данного разряда первого слагаемого, цифры 
данного разряда второго слагаемого и цифры (1 или 0) переноса из соседнего младшего 
разряда. В результате сложения для каждого разряда получаются цифры суммы для этого 
разряда и цифры (1 или 0) переноса в следующий старший разряд. 

С момента одновременной подачи слагаемых на входы сумматора определяется 
следующей формулой: 

t∑=ts +n·tp , 
где    ts - время формирования сигнала суммы в одном разряде; 

tp - время задержки сигнала переноса в одном разряде; 
n - число разрядов параллельного сумматора.  
Из приведённой формулы видно, что повысить быстродействие можно двумя 

способами: во-первых, уменьшением времени задержки сигнала переноса в одноразрядном 
сумматоре; во-вторых, уменьшением влияния числа разрядов на время распространения 
переноса. 
 
Варианты к выполнению задания 
Рассчитать сигнал сумматора в соответствии с вариантом 
 
N вар 1 2 3 4 5 6 
ts 2с 3с 4с 5с 1с 0,2с 
tp 0,1с 0,2с 0,3с 0,4с 0,5с 0,6с 
n 2 4 6 8 10 12 
 

Контрольные вопросы: 
1. Назначение, принципы построения. 
2. Булевы функции, описывающие работу одноразрядного полного сумматора. 
3. Полные и неполные сумматоры. 
4. Параллельные и последовательные сумматоры. 
5. Последовательный, параллельный и групповой переносы. 
6. Быстродействие многоразрядных сумматоров 
 
Литература 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                Васянович Н.А 

 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Практическое занятие №7 

Тема: Исследование работы дешифратора 
Цель: 1)Получить практические навыки по изучению требований, предъявляемых к 

дешифраторам 

           2) развивать интерес к изучаемой дисциплине 

Оснащение: методические указания к практической работе, компьютер 

 

Ход работы 

Теоретическое обоснование 

Дешифратор (декодер) — комбинационное устройство, преобразующее n-разрядный 
двоичный, троичный или k-ичный код в -ичный одноединичный код, где  - основание 



системы счисления. Логический сигнал, появляется на том выходе, порядковый номер 
которого соответствует двоичному, троичному или k-ичному коду. 

Дешифраторы являются устройствами, выполняющими двоичные, троичные или k-
ичные логические функции (операции). 

Двоичный дешифратор работает по следующему принципу: пусть дешифратор имеет 
N входов, на них подано двоичное слово xN − 1xN − 2...x0, тогда на выходе будем иметь 
такой код, разрядности меньшей или равной 2N, что разряд, номер которого равен 
входному слову, принимает значение единицы, все остальные разряды равны нулю. 
Очевидно, что максимально возможная разрядность выходного слова равна 2N. Такой 
дешифратор называется полным. Если часть входных наборов не используется, то число 
выходов меньше 2N, и дешифратор является неполным. 

Часто дешифраторы дополняются входом разрешения работы E. Если на этот вход 
поступает единица, то дешифратор функционирует, в ином случае на выходе дешифратора 
вырабатывается логический ноль вне зависимости от входных сигналов. 

Существуют дешифраторы с инверсными выходами, у такого дешифратора 
выбранный разряд показан нулём. 

Функционирование дешифратора описывается системой конъюнкций: 
 
 
 

 
 

 
Дешифраторы. Это комбинационные схемы с несколькими входами и выходами, 

преобразующие код, подаваемый на входы в сигнал на одном из выходов. На выходе 
дешифратора появляется логическая единица, на остальных — логические нули, когда на 
входных шинах устанавливается двоичный код определённого числа или символа, то есть 
дешифратор расшифровывает число в двоичном, троичном или k-ичном коде, представляя 
его логической единицей на определённом выходе. Число входов дешифратора равно 
количеству разрядов поступающих двоичных, троичных или k-ичных чисел. Число 
выходов равно полному количеству различных двоичных, троичных или k-ичных чисел 
этой разрядности. 

 

 

Задание 

Дайте определение  

Nвар 1 2 3 4 

 шифратор дешифратор ОЗУ и ПЗУ Ячейка памяти 

 

Контрольные вопросы: 

1. Для чего предназначен шифратор? 
2. Какую функцию выполняет шифратор? 
3. Где в ПК используется шифратор? 

 

Список литературы 



1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 
учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                Васянович Н.А 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Практическая работа №8 

Тема: Исследование работы шифратора 
Цель: 1)Получить практические навыки по изучению требований, предъявляемых к 

шифраторам 

           2) развивать интерес к изучаемой дисциплине 

Оснащение: методические указания к практической работе, компьютер 

 

Ход работы 

Теоретическое обоснование 



Шифратор (кодер) — (англ. encoder) логическое устройство, выполняющее 
логическую функцию (операцию) — преобразование позиционного n-разрядного кода в m-
разрядный двоичный, троичный или k-ичный код. 

Двоичный шифратор выполняет логическую функцию преобразования унитарного n-
ичного однозначного кода в двоичный. При подаче сигнала на один из n входов 
(обязательно на один, не более) на выходе появляется двоичный код номера активного 
входа. 

Если количество входов настолько велико, что в шифраторе используются все 
возможные комбинации сигналов на выходе, то такой шифратор называется полным, если 
не все, то неполным. Число входов и выходов в полном шифраторе связано соотношением: 

где 
 — число входов, 

 
 — число выходных двоичных разрядов. 
Троичный шифратор выполняет логическую функцию преобразования унарно n-

ичного однозначного (одноединичного или однонулевого) кода в троичный. При подаче 
сигнала («1» в одноединичном коде или «0» в однонулевом коде) на один из n входов на 
выходе появляется троичный код номера активного входа. 

Число входов и выходов в полном троичном шифраторе связано соотношением: 
, где 

 
 — число входов, 

 
 — число выходных троичных разрядов. 
Число входов и выходов в полном k-ичном шифраторе связано соотношением: 

, где 
 

 — число входов, 
 

 — число выходных k-ичных разрядов, 
 

 — основание системы счисления. 
Приоритетный шифратор отличается от шифратора наличием дополнительной 

логической схемы выделения активного уровня старшего входа для обеспечения условия 
работоспособности шифратора (только один уровень на входе активный). Уровни сигналов 
на остальных входах схемой игнорируются. 

 

Задание 

Дайте определение  

Nвар 1 2 3 4 

 шифратор дешифратор ОЗУ и ПЗУ Ячейка памяти 

 

Контрольные вопросы: 

4. Для чего предназначен шифратор? 
5. Какую функцию выполняет шифратор? 
6. Где в ПК используется шифратор? 



 

Список литературы 
1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 

учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 

 
Составил преподаватель                                                Васянович Н.А 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Практическое занятие №9 
Тема: Исследование работы мультиплексора 
Цель: 1) Сформировать практические навыки при изучении схемы мультиплексора и ее 
функциональных узлов. 

2) развивать интерес к изучаемой дисциплине 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

Mультиплексор — устройство, имеющее несколько сигнальных входов, один или 
более управляющих входов и один выход. Мультиплексор позволяет передать сигнал с 



одного из входов на выход; при этом выбор желаемого входа осуществляется подачей 
соответствующей комбинации управляющих сигналов. 

Аналоговые и цифровые мультиплексоры значительно различаются по принципу 
работы. Первые электрически соединяют выбранный вход с выходом (при этом 
сопротивление между ними невелико — порядка единиц/десятков ом). Вторые же не 
образуют прямого электрического соединения между выбранным входом и выходом, а 
лишь «копируют» на выход логический уровень ('0' или '1') с выбранного входа. 
Аналоговые мультиплексоры иногда называют ключами. 

Схематически мультиплексор можно изобразить в виде коммутатора, 
обеспечивающего подключение одного из нескольких входов (их называют 
информационными) к одному выходу устройства. Коммутатор обслуживает управляющая 
схема, в которой имеются адресные входы и, как правило, разрешающие (стробирующие). 
Сигналы на адресных входах определяют, какой конкретно информационный канал 
подключен к выходу. 

Разрешающие входы используют для расширения функциональных возможностей 
мультиплексора. Они используются для наращивания разрядности мультиплексора, 
синхронизации его работы с работой других узлов. Сигналы на разрешающих входах 
могут разрешать, а могут и запрещать подключение определенного входа к выходу, то есть 
могут блокировать действие всего устройства. 

В качестве управляющей схемы обычно используется дешифратор. В цифровых 
мультиплексорах логические элементы коммутатора и дешифратора обычно 
объединяются. 

Обобщённая схема мультиплексора 

  
      Р и с у н о к  1  - Обобщённая схема мультиплексора 
 

Входные логические сигналы Xi поступают на входы коммутатора и через 
коммутатор передаются на выход Y. На вход управляющей схемы подаются адресные 
сигналы Ak (от англ. Address). Мультиплексор также может иметь дополнительный 
управляющий вход E (от англ. Enable), который разрешает или запрещает прохождение 
входного сигнала на выход Y. 

Кроме этого, некоторые мультиплексоры могут иметь выход с тремя состояниями: 
два логических состояния 0 и 1, и третье состояние — отключённый выход (выходное 
сопротивление равно бесконечности, высокоимпедансное Z-состояние). Перевод 
мультиплексора в третье состояние производится снятием управляющего сигнала OE (от 
англ. Output Enable). 

 
Задание 1: Обозначить элементы на схемах мультиплексора 

N вар 1 вариант 2 вариант 



 

 

 
 
Контрольные вопросы: 
1. Дать определение мультиплексору. 
2. Построить схему мультиплексора, обозначив все функциональные узлы 
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Практическое занятие №10 
Тема: Исследование работы демультиплексора 
Цель: 1)Сформировать практические навыки при изучении схемы демультиплексора и ее 
функциональных узлов 
              2) развивать интерес к изучаемой дисциплине 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

Демультиплексор — устройство, в котором сигналы с одного информационного входа 
поступают в желаемой последовательности по нескольким выходам в зависимости от кода 



на адресных шинах. Таким образом, демультиплексор в функциональном отношении 
противоположен мультиплексору. Демультиплексоры обозначают через DMX или DMS. 
Если между числом выходов и числом адресных входов действует соотношение n=2m для 
двоичных демультиплексоров или n=3m для троичных демультиплексоров, то такой 
демультиплексор называют полным. Если n<2m для двоичных демультиплексоров или 
n<3m для троичных демультиплексоров, то демультиплексор называют неполным. 
Функции демультиплексоров сходны с функциями дешифраторов. Дешифратор можно 
рассматривать как демультиплексор, у которого информационный вход поддерживает 
напряжение выходов в активном состоянии, а адресные входы выполняют роль входов 
дешифратора. Поэтому в обозначении как дешифраторов, так и демультиплексоров 
используются одинаковые буквы - ИД. 

Демультиплексоры выполняют унарные (одновходовые, однооперандные) логические 
функции с n-арным выходом. 

Схема демультиплексора приведена на рисунке . В этой схеме для выбора 
конкретного выхода демультиплексора, как и в мультиплексоре, используется двоичный 
дешифратор. 
 
 

 
Р и с у н о к  1 -  Принципиальная схема демультиплексора, управляемого двоичным 

кодом. 
 
Если  рассмотреть принципиальную схему самого дешифратора, то можно 

значительно упростить демультиплексор. Достаточно просто к каждому логическому 
элементу 'И', входящему в состав дешифратора просто добавить ещё один вход – In. Такую 
схему часто называют дешифратором с входом разрешения работы. Условно-графическое 
изображение демультиплексора приведено на рисунке. 
 

 
    Р и с у н о к  2  - Условно графическое обозначение демультиплексора с четырьмя 
выходами. 
 

В этом обозначении вход In обозначен как вход E, а выходы не названы никак, 
оставлены только их номера. 



В МОП микросхемах не существует отдельных микросхем демультиплексоров, так 
как МОП мультиплексоры, описанные ранее по информационным сигналам не различают 
вход и выход, т.е. направление распространения информационных сигналов, точно также 
как и в механических ключах, может быть произвольным. Если поменять входы и выход 
местами, то КМОП мультиплексоры будут работать в качестве демультиплексоров. 
Поэтому их часто называют просто коммутаторами. 

 
Задание1: Обозначить элементы на схемах демультиплексора 

N 
вар 

1 вариант 2 вариант 

 

 
 

 
Контрольные вопросы: 
1. Дать определение демультиплексору. 
2. Построить схему демультиплексора, обозначив все функциональные узлы 
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Практическое занятие №11 
Тема: Исследование работы АЛУ 
Цель: 1)Сформировать практические навыки при изучении схемы АЛУ и ее 
функциональных узлов 
              2) развивать интерес к изучаемой дисциплине 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 



Арифметическо-логическое устройство (АЛУ) – это практически сердце процессора. 
Это то, что позволяет процессору складывать, вычитать, а также выполнять базовые 
логические операции вроде И\ИЛИ. Так как каждый компьютер должен уметь выполнять 
эти простые функции, АЛУ всегда присутствует в процессоре. То, как производитель 
организует АЛУ, определяет в дальнейшем общую производительность процессора. 

Все выполняемые в АЛУ операции являются логическими операциями (функциями), 
которые можно разделить на следующие группы: 

операции двоичной арифметики для чисел с фиксированной точкой; 
операции двоичной (или шестнадцатеричной) арифметики для чисел с плавающей 

точкой; 
операции десятичной арифметики; 
операции индексной арифметики (при модификации адресов команд); 
операции специальной арифметики; 
операции над логическими кодами (логические операции); 
операции над алфавитно-цифровыми полями. 
По способу представления чисел различают АЛУ: 
для чисел с фиксированной точкой; 
для чисел с плавающей точкой; 
для десятичных чисел. 
По характеру использования элементов и узлов АЛУ делятся на блочные и 

многофункциональные. В блочном АЛУ операции над числами с фиксированной и 
плавающей точкой, десятичными числами и алфавитно-цифровыми полями выполняются в 
отдельных блоках, при этом повышается скорость работы, так как блоки могут 
параллельно выполнять соответствующие операции, но значительно возрастают затраты 
оборудования. В многофункциональных АЛУ операции для всех форм представления 
чисел выполняются одними и теми же схемами, которые коммутируются нужным образом 
в зависимости от требуемого режима работы. 

По своим функциям АЛУ является операционным блоком, выполняющим 
микрооперации, обеспечивающие приём из других устройств (например, памяти) 
операндов, их преобразование и выдачу результатов преобразования в другие устройства. 
Арифметико-логическое устройство управляется управляющим блоком, генерирующим 
управляющие сигналы, инициирующие выполнение в АЛУ определённых микроопераций. 
Генерируемая управляющим блоком последовательность сигналов определяется кодом 
операции команды и оповещающими сигналами. 

 
 
 
 
Задание 1: Построить схему АЛУ, обозначить элементы, описать принцип работы 

N вар 1 вариант 2 вариант 



 

 

 
 
Контрольные вопросы: 
1. Дать определение АЛУ 
2. Построить схему АЛУ, обозначив все функциональные узлы 
3. Какую роль играет АЛУ в вычислительной системе процессора? 
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Практическое занятие №12 



Тема: Исследование работы компаратора 
Цель: 1)Сформировать практические навыки при изучении схемы компаратора и ее 
функциональных узлов 
              2) развивать интерес к изучаемой дисциплине 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Компаратор (аналоговых сигналов) (англ. comparator — сравнивающее устройство) — 

электронная схема, принимающая на свои входы два аналоговых сигнала и выдающая 
логическую «1», если сигнал на прямом входе («+») больше чем на инверсном входе («−»), 
и логический «0», если сигнал на прямом входе меньше, чем на инверсном входе. 

Простейший компаратор представляет собой дифференциальный усилитель. 
Компаратор отличается от линейного операционного усилителя (ОУ) устройством и 
входного, и выходного каскадов: 

Входной каскад компаратора должен выдерживать широкий диапазон входных 
напряжений между инвертирующим и неинвертирующим входами, вплоть до размаха 
питающих напряжений, и быстро восстанавливаться при изменении знака этого 
напряжения. В ОУ, охваченном обратной связью, это требование некритично, так как 
дифференциальное входное напряжение измеряется милливольтами и микровольтами. 

Выходной каскад компаратора выполняется совместимым по уровням и токам с 
конкретным типом логических схем (ТТЛ, ЭСЛ и т. п.). Возможны выходные каскады на 
одиночном транзисторе с открытым коллектором (совместимость с ТТЛ и КМОП 
логикой). 

При подаче эталонного напряжения на инвертирующий вход, входной сигнал 
подаётся на неинвертирующий вход и компаратор является неинвертирующим 
(повторителем, буфером). 

При подаче эталонного напряжения на неинвертирующий вход, входной сигнал 
подаётся на инвертирующий вход и компаратор является инвертирующим (инвертором). 

Несколько реже применяются компараторы на основе логических элементов, 
охваченных обратной связью (см., например, триггер Шмитта — не компаратор по своей 
природе, но устройство с очень схожей областью применения). 

При математическом моделировании компаратора возникает проблема выходного 
напряжения компаратора при одинаковых напряжениях на обоих входах компаратора. В 
этой точке компаратор находится в состоянии неустойчивого равновесия. Проблему 
можно решить, если принять доопределение, что, в точке неустойчивого равновесия 
выходное напряжение компаратора остаётся в предыдущем состоянии. 
 
Задание 1: Построить схему компаратора, обозначить элементы, описать принцип работы 
N вар 1 вариант 2 вариант 
 

 
 

 



Контрольные вопросы: 
1. Дать определение компаратору 
2. Построить схему компаратора, обозначив все функциональные узлы 
3. Какую роль играет компаратор в вычислительной системе ЭВМ? 
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Практическое занятие№13 



 
Тема: Моделирование цифровых схем в программе gEDA 
Цель: 1)Сформировать практические навыки при изучении программного обеспечения 
gEDA 
            2) развивать интерес к изучаемой дисциплине 
Оснащение: МУ к ПР, компьютер, ПО gEDA 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
 
Задание 1. Запустите программу gEDA. Постройте и проверьте схему согласно своему 
варианту 
 
N 
ва
р 

1 вариант 2 вариант 

 

 

 
 3 вариант 4 вариант 
 

 

 

 



Контрольные вопросы: 
 
1. Для чего предназначен редактор gEDA? 
2. Как открыть библиотеку программы? 
3. Как выбрать компонент библиотеки gEDA? 
4. Какие модули входят в состав gEDA? 
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Практическое занятие№14 



Тема: Исследование последовательного цифрового устройства 
Цель: 1)Сформировать практические навыки при изучении схемы последовательного 
цифрового устройства и его функциональных узлов 
              2) развивать интерес к изучаемой дисциплине 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

Последовательностные цифровые устройства (ПЦУ) характеризуются тем, что 
выходные сигналы зависят не только от текущих значений входных сигналов, но и от 
последовательности значений входных сигналов, поступивших на входы в 
предшествующие моменты времени. 

Триггер — простейшее ПЦУ, предназначенное для записи и хранения одноразрядных 
двоичных чисел. 

 Входные триггера разделяются на информационные и управляющие. 
 Информационные входы обозначаются следующим образом: 
 S — вход для установки в состояние «1»; 
 R — вход для установки в состояние «0»; 
 J — вход для установки в состояние «1» в универсальном триггере; 
 K- вход для установки в состоянии «0» в универсальном триггере; 
 Т — счётный (общий) вход; 
 D — вход для установки в состояние «1» или состояние «0». 
Регистр — это последовательное логическое устройство, используемое для хранения n 

— разрядных двоичных чисел и выполнения преобразований над ними. Регистр 
представляет собой упорядоченную последовательность триггеров, число которых 
соответствует числу разрядов в слове (обычно от 4 до 16). На схемах регистры 
обозначаются буквами RG. Регистр обеспечивает выполнение следующих типичных 
операций:  

 приём слова в регистр; 
 передача слова из регистра; 
 поразрядные логические операции; 
 сдвиг слова влево или вправо на заданное число разрядов; 
 преобразование последовательного кода слова в параллельный и обратно; 
 установка регистра в начальное состояние (сброс). 
Счётчики представляют более высокий, чем регистры, уровень сложности цифровых 

микросхем, имеющих внутреннюю память. Хотя в основе любого счётчика лежат те же 
самые триггеры, которые образуют и регистры, но в счётчиках триггеры соединены более 
сложными связями, в результате чего их функции сложнее, и на их основе можно строить 
более сложные устройства, чем на регистрах. 

Цифровые запоминающими называют устройства, предназначены для записи, 
хранения и считывания информации, представленной в цифровом коде. Они представляют 
собой более сложные цифровые устройства по сравнению с рассмотренным ранее. Каждый 
код хранится в отдельном элементе, называемом ячейкой памяти. 

 К основным параметром запоминающих устройств (ЗУ) относятся информационная 
ёмкость, потребляемая мощность, время хранения кодов, быстродействие. 

ОЗУ (RAM) подразделяются на статически и динамические. 
 Каждая ячейка оперативной (статической) памяти представляет собой, по сути, 

регистр из триггерных ячеек, в который может быть записана информация и из которой 



можно информацию читать. Выбор того или иного регистра (той или иной ячейки памяти) 
производится с помощью кода адреса памяти 

В ПЗУ информация заносится раз и навсегда. 
 ПЗУ можно разделить на следующие группы:  
 Программируемые при изготовление (обозначают как ПЗУ или ROM); 
 С однократным программированием, позволяющим пользователю однократно 

изменить состояние матрицы памяти электрическим путём по заданной программе 
(обозначают как ППЗУ или PROM); 

 Перепрограммируемые (репрограммируемые), с возможностью многократного 
электрического перепрограммирования, с ультрафиолетовым (обозначают как РПЗУУФ 
или EPROM) или электрическим (обозначают как РПЗУЭС или EEPROM, или ) cтиранием 
информации. 
 
Задание1: Построить схему последовательного цифрового устройства, описать 

принцип ее работы 
 

N вар 1 вариант 2 вариант 3 вариант 4 вариант 
 ОЗУ ПЗУ регистр счетчик 

 
Контрольные вопросы: 
1. Дать определение последовательным ЦУ 
2. В чем отличие устройств последовательного типа от комбинационного? 
3. Какие устройства относят к устройствам последовательного типа? 

 
Список литературы: 

1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 
учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 
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Практическое занятие №15 
Тема: Исследование регистра сдвига 



Цель: 1)Сформировать практические навыки при изучении схемы последовательного 
цифрового устройства и его функциональных узлов 
              2) развивать интерес к изучаемой дисциплине 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Кроме операции хранения данных регистры могут использоваться и для операции 

сдвига данных с целью преобразования двоичного последовательного кода в 
параллельный и наоборот. Это так называемые сдвиговые регистры или регистры сдвига, 
которые получаются путем цепочного соединения триггеров. 
Суть сдвига состоит в том, что по сигналу синхроимпульса происходит одновременная 

перезапись содержимого каждого триггера в соседний триггер. При этом не меняется само 
двоичное слово (число), записанное в регистре, оно лишь сдвигается на один разряд и 
только содержимое последнего триггера ТТ3 пропадает из регистра, а на вход первого ТТ0 
поступает новый бит. 

 

 
 
Р и с у н о к  – Регистр сдвига 
 
Сдвигающий регистр в отличие от регистра памяти должен обязательно состоять из 

непрозрачных триггеров, иначе при первом же сигнале сдвига бит, поступивший на вход 
первого триггера регистра сдвига, сразу же пройдёт на выход этого триггера и 
соответственно, на вход второго триггера, а значит и на выход второго триггера и т. д. до 
последнего триггера регистра сдвига. 
В некоторых сдвиговых регистрах сдвиг происходит не только в одну сторону, а и 

влево и вправо - это так называемые реверсивные регистры. 
 
 
 
 
 
 
 
 
 
 
Задание 1: Построить схему регистра сдвига, описать принцип ее работы 
 
N вар 1 вариант 2 вариант 



 

  
 
Контрольные вопросы: 
1. Дать определение последовательным регистру сдвига 
2. В чем отличие устройств последовательного типа от комбинационного? 
3. Какие устройства относят к устройствам последовательного типа? 

 
Список литературы: 

1. А. В. Кистрин, М. Б. Никифоров. Проектирование цифровых устройств : 
учебник для студентов учреждений среднего профессионального образования. 
Издательство: Академия, Год издания: 2016 
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Практическое занятие №16 
Тема: Исследование интегральной микросхемы 



Цель: 1)Сформировать практические навыки при изучении интегральной микросхемы и ее 
функциональных узлов 
              2) развивать интерес к изучаемой дисциплине 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

Интегра́льная (микро)схе́ма (ИС, ИМС, м/сх, англ. integrated circuit, IC, microcircuit), 
чип, микрочи́п (англ. microchip, silicon chip, chip — тонкая пластинка — первоначально 
термин относился к пластинке кристалла микросхемы) — микроэлектронное устройство 
— электронная схема произвольной сложности (кристалл), изготовленная на 
полупроводниковой подложке (пластине или плёнке) и помещённая в неразборный корпус, 
или без такового, в случае вхождения в состав микросборки. 

Интегральная микросхема выполняет определенные функции обработки 
(преобразования) информации, заданной в виде электрических сигналов: напряжений или 
токов. Электрические сигналы могут представлять информацию в непрерывной 
(аналоговой), дискретной и цифровой форме. 

Компоненты, входящие в состав ИС, не могут быть выделены из нее в качестве 
самостоятельных изделий, кроме того, они характеризуются некоторыми особенностями 
по сравнению с дискретными транзисторами, диодами и т. д. 

Особенностью цифровых ИС является высокая сложность выполняемых ими 
функций, поэтому количество компонентов в одной микросхеме может исчисляться 
сотнями тысяч и даже миллионами. 

Функциональную сложность ИС обычно характеризуют степенью компонентной 
интеграции, т. е. количеством чаще всего транзисторов на кристалле. Количественно 
степень интеграции описывается условным коэффициентом K = lg N , где N – число 
компонентов. 

В зависимости от значений K интегральные схемы подразделяются: 
K < 2, (N < 100) – малая интегральная схема (МИС или IS); 
2 < K < 4, (N < 104) – интегральная схема средней степени интеграции (СИС или MSI); 
4 < K < 5, (N < 106) – большая интегральная схема (БИС или LSI); 
K > 6, (N > 106) – сверхбольшая интегральная схема (СБИС или VLSI). 
Сокращения приведенные на английском языке имеют следующий смысл: IS – 

Integrated Circuit; MSI – Medium Scale Integration; LSI – Large Scale Integration; VLSI – Very 
Large Scale Integration. 

Иногда сложность ИС характеризуют таким показателем, как плотность упаковки. Это 
количество компонентов, приходящихся на единицу площади кристалла. Этот показатель 
характеризует уровень технологии, и в настоящее время он составляет более 104 
компонентов/мм2. 

 
 

 
 
 
 
 

Задание1: Построить схему ИС, описать принцип ее работы 
 



N вар 1 вариант 2 вариант 
 

 

 

 
Контрольные вопросы: 
1. Дать определение интегральной схеме 
2. Приведите пример использования интегральных схем в ПК 
3. Какие устройства выполнены на интегральных схемах? 

 
Список литературы: 
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Практическое занятие №17 
Тема: Исследование и расчет счетчика импульса 



Цель: 1)Сформировать практические навыки при исследовании и расчете счетчика 
импульсов 
              2) развивать интерес к изучаемой дисциплине 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

Счетчик – устройство для подсчета числа входных импульсов. Число, представляемое 
состоянием его выходов по фронту каждого входного импульса, изменяется на единицу. 
Счетчик можно реализовать на нескольких триггерах. В суммирующих счетчиках каждый 
входной импульс увеличивает число на его выходе на единицу, в вычитающих счетчиках 
каждый входной импульс уменьшает это число на единицу. 

Счетчики можно реализовать на триггерах. При этом триггеры соединяют 
последовательно. Выход каждого триггера непосредственно действует на тактовый вход 
следующего. Для того чтобы реализовать суммирующий счетчик, необходимо счетный 
вход очередного триггера подключать к инверсному выходу предыдущего. Для того чтобы 
изменить направление счета (реализовать вычитающий счетчик), можно предложить 
следующие способы:  

а) считывать выходные сигналы счетчика не с прямых, а с инверсных выходов 
триггеров. Число, образуемое состоянием инверсных выходов триггеров счетчика, связано 
с числом, образованным состоянием прямых выходов триггеров следующим 
соотношением:  
 

NПР = 2n – NИНВ – 1; 
 
б) изменить структуру связей в счетчике: подавать на счетный вход следующего 

триггера сигнал не с инверсного, а с прямого выхода предыдущего. 
 
Задание 1: Проведите расчет счетчика по следующим схемам 
 
N вар 1 вариант. Суммирующий счетчик 
 

 
 



 
 2 вариант. Вычитающий счетчик 
 

 
 
Контрольные вопросы: 
1. Дать суммирующему и вычитающему счетчику. 
2. Приведите пример использования счетчиков в ЭВМ 
3. Как проводится расчет счетчика импульсов? 

 
Список литературы: 
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Практическое занятие №18 
Тема: Исследование счетчика с последовательным переносом 
Цель: 1)Сформировать практические навыки при исследовании счетчика с 
последовательным переносом 
              2) развивать интерес к изучаемой дисциплине 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 

Счётчики с последовательным переносом. В этих счётчиках импульсы, подлежащие 
счёту, поступают на вход только одного первого триггера, а сигнал переноса передаётся 
последовательно от одного разряда к другому. Такие счётчики отличаются простотой 
схемы, но имеют невысокое быстродействие. 

Основными показателями счётчиков являются ёмкость и быстродействие. 
Ёмкость, численно равная  КСЧ, характеризует число импульсов, доступное счёту за 

один цикл. Как уже было показано выше, ёмкость определяется количеством разрядов 
счётчика. 

Быстродействие или максимально возможная скорость работы оценивается двумя 
параметрами: 

– Разрешающая способность tраз.сч — минимальное время между двумя входными 
сигналами, в течение которого ещё не возникают сбои в работе счётчика. Величина, 
обратная разрешающей способности, называется максимальной частотой счёта fmax. fmax  
определяет количество импульсов, которое может подсчитать счётчик за 1 сек. 

 
fmax = 1/tраз.сч 
 
– Время установки кода счётчика tуст — это время между моментом прихода 

входного сигнала и переходом счётчика в новое устойчивое состояние. 
Для удовлетворения потребностей разработчиков цифровых электронных устройств 

различного назначения разработаны интегральные микросхемы счётчиков с широким 
спектром параметров. Всё многообразие счётчиков можно классифицировать по 
следующим признакам. 

1 По направлению счёта: 
 • Суммирующие, 
 • Вычитающие, 
 • Реверсивные. 
2 По коэффициенту счёта: 
 • Двоичные, 
 • Двоично-десятичные (декадные), 
 • С постоянным произвольным коэффициентом счёта, 
 • С переменным коэффициентом счёта. 
3 По способу организации внутренних связей: 
 • С последовательным переносом, 
 • С параллельным переносом, 
 • С комбинированным переносом, 
 • Кольцевые. 



Классификационные признаки независимы и могут встречаться в разных сочетаниях. 
Например, суммирующие счётчики могут быть как с последовательным, так и с 
параллельным переносом и могут иметь двоичный или десятичный коэффициент счёта. 
 
Задание1: Постройте схему согласно варианту и опишите принцип ее работы 
N 
вар 

1 вариант 2 вариант 3 вариант 4 вариант 

 Счётчик с 
произвольным 
коэффициентом 
счёта 
 

Вычитающий 
счетчик 

Реверсивный 
счетчик 

Суммирующий 
счетчик 

 
Контрольные вопросы: 
1. Дать суммирующему и вычитающему счетчику. 
2. Приведите пример использования счетчиков в ЭВМ 
3. Как проводится расчет счетчика по основным показателям, характеризующих его 

работу? 
 

Список литературы: 
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Практическое занятие №19 
Тема: Исследование счетчика с параллельным переносом 
Цель: 1)Сформировать практические навыки при исследовании счетчика с параллельным 
переносом 
              2) развивать интерес к изучаемой дисциплине 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Счётчики с параллельным переносом строятся на синхронных триггерах. 
Счётные импульсы подаются одновременно на тактовые входы всех триггеров, а 

каждый из триггеров цепочки служит по отношению к последующим только источником 
сигналов. Срабатывание триггеров параллельного счётчика происходит синхронно, и 
задержка переключения всего счётчика равна задержке для одного триггера. 
Следовательно, такие счётчики более быстродействующие. Их основным недостатком 
является большая мощность, потребляемая от источника входных сигналов, так как 
входные импульсы подаются на тактовые входы всех триггеров. 

Для устранения недостатков рассмотренных выше счётчиков разработаны и 
используются счётчики с последовательно-параллельным переносом. 

В счётчиках с последовательно-параллельным переносом триггеры объединены в 
группы так, что отдельные группы образуют счётчики с параллельным переносом, а 
группы соединяются с последовательным переносом. В роли групп могут быть и готовые 
счётчики. 

Общий коэффициент счёта таких счётчиков равен произведению коэффициентов 
счёта всех групп. 

В качестве примера рассмотрим счётную декаду на JK-триггерах, приведённую на 
рисунке 1 

  

 
 
Р и с у н о к  1  -Счётная декада на JK-триггерах 

 
Схема состоит из двух групп. Первая группа — это триггер DD1.  
Вторая группа, состоящая из трёх триггеров DD2–DD4, представляет собой счётчик с 

параллельным переносом и тактируется выходным сигналом первого триггера. Группы 
соединены между собой последовательно. 

Схема работает следующим образом. 
При подаче на вход импульсов с 1-го по 8-ой декада работает как обычный двоичный 

счётчик импульсов. 
К моменту прихода 8-го импульса на двух входах J 4-го триггера формируется 

уровень лог. «1». 8-ым импульсом этот триггер переключается в состояние лог. «1», а 



уровень лог. «0» с его инверсного выхода, подаваемый на вход «J» второго триггера, 
запрещает его переключение в единичное состояние под действием 10-го импульса. 

10-ый импульс восстанавливает нулевое состояние 4-го триггера и цикл работы 
счётчика повторяется. 
 
Задание1: Постройте схему согласно варианту и опишите принцип ее работы 
N 
ва
р 

1 вариант 2 вариант 

 

 
Контрольные вопросы: 
1. Дать определение  счетчику с параллельным переносом. 
2. Приведите пример использования счетчиков с параллельным переносом  в ЭВМ 
3. В чем отличие счетчика с параллельным переносом от счетчика с последовательным 

переносом? 
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Практическое занятие №20 
Тема: Исследование триггера Шмита 
Цель: 1)Сформировать практические навыки при исследовании триггера Шмита 
              2) развивать интерес к изучаемой дисциплине 
Оснащение: Му к ПР, схема 
 

Порядок выполнения работы 
 

Краткие теоретические сведения 
 
Триггеры — это электронные устройства, обладающие двумя устойчивыми 

состояниями равновесия и способные скачком переходить из одного устойчивого 
состояния в другое под воздействием внешних управляющих сигналов. 

Триггер Шмитта (не Шмидта) — электронная модель двухпозиционного релейного 
элемента, статическая характеристика которого имеет зону неоднозначности (петлю 
гистерезиса). Структурно, триггер Шмитта представляет собой усилитель с достаточно 
большим коэффициентом усиления, охваченный глубокой положительной обратной 
связью. Триггер Шмитта используется для восстановления цифрового сигнала, 
искаженного в линиях связи, фильтрах дребезга, в качестве двухпозиционного регулятора 
в системах автоматического регулирования. Этот триггер стоит особняком в семействе 
триггеров: он имеет один аналоговый вход и один выход. 

Триггеры Шмитта представляют собой специфические логические элементы, 
специально рассчитанные на работу с входными аналоговыми сигналами. Они 
предназначены для преобразования входных аналоговых сигналов в выходные цифровые 
сигналы. Появление таких микросхем связано в первую очередь с необходимостью 
восстановления формы цифровых сигналов, искаженных в результате прохождения по 
линиям связи. Фронты таких сигналов оказываются пологими, в результате чего форма 
сигналов вместо прямоугольной может стать близкой к треугольной или синусоидальной. 
К тому же сигналы, передаваемые на большие расстояния, сильно искажаются шумами и 
помехами. Восстановить их форму в исходном виде, устранить влияние помех и шумов как 
раз и призваны триггеры Шмитта. 

 

 
 
Р и с у н о к  1  – Триггеры Шмита 

 
 
 
 
 
 
 
 
 
 
 



Задание1: Постройте схему согласно варианту и опишите принцип ее работы 
N 
ва
р 

1 вариант 2 вариант 

 

 

 
 3 вариант 4 вариант 
 

 
Контрольные вопросы: 
1. Дать определение  триггеру Шмитта 
2. Приведите пример использования счетчиков Шмита   в ЭВМ 
3. В чем особенность триггеров Шмитта? 
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